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ScanWizard for Windows consists of four major windows: Preview, Settings, 
Information, and Scan Job. The Preview and Settings windows appear automatically 
after ScanWizard for Windows is started up. The Scan Job and Information windows, 
however, are hidden, and to see them, go to the View menu in the Preview window 
and click on the commands Show Job window and Show Info Window.
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Bit
The smallest unit of memory in the computer. A bit can be either off or on, 
representing a value of 0 or 1. Greater bit-depth translates to more complexity in 
image information. 



Single-bit
Single-bit images use just one bit of data to record each pixel either black or white.



8-bit grayscale
Images that contain 256 possible shades of gray needed to represent most black-
and-white photos accurately. 256 levels of gray is actually more shades of gray than 
the human eye can see.



24-bit color
24-bit color images are composed of three 8-bit color channels. When combined, the 
red, green and blue channels provide up to 16.7 million a possible combinations 
(hence, colors). 24-bit color is also known as True Color and photo-realistic color.



36-bit color
36-bit color images are composed of three 12-bit color channels. When combined, the
red, green and blue channels provide up to 68.7 billion possible combinations that 
translate into that many "colors." (This compares to 16.7 million colors for 24-bit 
scanners.) The extra amount of information that can be processed by 36-bit scanners 
translates to more vivid color reproduction, as the scanner is able to accommodate 
more subtle gradations of color approaching lifelike accuracy.



Auto Document Feeder (ADF)
A scanner accessory that helps with text scanning. The ADF allows continuous 
scanning of up to 50 pages of text. This accessory is normally used with an 
OCR(Optical Character Recognition) software program, not an image-editing program 
like Adobe Photoshop or Microtek ImageStar II.



Brightness
The balance of light and dark shades in an image. Brightness is distinct from contrast,
which measures the range between the darkest and lightest shades in an image. 
Brightness determines the intensity of shades; contrast determines the number of 
shades you get.



Color calibration
The process of ensuring accurate reproduction of color for images. Full color 
calibration is usually a two-step process: calibrating your input device, such as a 
scanner; and calibrating your output device, such as a printer or monitor. By 
calibrating input and output devices correctly, color is accurately captured by your 
scanner and is reproduced faithfully on your monitor or printer as well.



CCD
Stands for charge-coupled device, a strip of light-sensitive cells that converts light 
waves reflected from an image during scanning into digital information.



Color channel
Refers to the red, green, and blue components from which colors are created.



Color Image
An image type that contains the most complex information (compared to single-bit 
and grayscale images). To capture color images, scanners use a process based on the
RGB color model.



Contrast
The relationship between the light and dark areas of an image. Contrast is the range 
between the darkest and lightest shades in an image, while brightness is the balance 
of light and dark shades. Contrast determines the number of shades you get; 
brightness determines the intensity of the shades. An image with low contrast tends 
to look dull and flat.



DCR
Stands for Dynamic Color Rendition, Microtek's exclusive color calibration and color 
correction technology. DCR ensures that reproduced colors in your scanned image 
match those of the original as closely as possible. 



Dpi
Stands for dots per inch, the measure of resolution. The greater the dpi number, the 
higher the resolution.



Dynamic range
The ability of a scanner to register a wide range of tonal valuessomething from near 
white to near black. A scanner with good dynamic range is able to map input shades 
correctly to output shades, making images look brighter and with more visible detail. 
Generally, the number of bits determines the maximum dynamic range of a scanner. 
For example, a 36-bit scanner has a higher dynamic range than a 24-bit scanner.



Exposure
The amount of light in an image. The exposure of an image can be changed by 
increasing or reducing available light. 



File format
The way a graphic file is saved. Several file formats are available for use, and each 
one has its own advantages and disadvantages. Among the most popular file formats 
are TIFF, PICT, EPS, and PCX. 



Filters
Tools that allow you to apply or create special effects to your images. Filters in your 
scanning software include Blur/Blur More, Sharpen/Sharpen More, Emboss, Enhance 
Edges, and Unsharp Masking.



Gamma
The contrast affecting the mid-level grays or midtones of an image. Adjusting the 
gamma of an image allows you to change brightness values of the middle range of 
gray tones without dramatically altering the shadows and highlights.



Grayscale
An image type that contains more than just black and white, and includes actual 
shades of gray. In a grayscale image, each pixel has more bits of information encoded
in it, allowing more shades to be recorded and shown. 4 bits are needed to reproduce
up to 16 levels of gray, and 8 bits can reproduce a photo-realistic 256 shades of gray.



Halftone
A type of single-bit image composed of a pattern of black dots that fool the eye into 
seeing shades of gray. Examples of halftone images are the pictures you see in a 
newspaper. These images usually look very coarse.



Highlights
The lightest portions of an image.



Histogram
A graphic representation of how brightness and darkness pixels are distributed in an 
image. A histogram skewed heavily to the left indicates a dark image, while a 
histogram skewed to the right indicates a light image.



Hue
The aspect of color that distinguishes it from another color (what makes a color red or
green or blue). Hue is distinct from saturation, which measures the intensity of the 
hue (more red, more green).



Image-editing software
Software that is used to edit images, such as Adobe Photoshop.



Image enhancement tools
Tools in your scanning software for adjusting the color and quality of images. These 
tools include Brightness, Contrast and Exposure; Shadows and Highlights; Tints; 
Curve;    Filters; and More Options.



Image Type
The way you wish an image to be scanned and processed. ScanWizard lets you 
reproduce an image as halftone, line art, grayscale, or color.



Imagesetter
An output device used to render high-resolution images or documents on 
photographic paper or film.



Interpolated resolution
Resolution enhanced through software; thus also known as software-enhanced 
resolution. For instance, if your optical resolution is 300 dpi you may be able to 
enhance images up to 600 dpi through software interpolation. Interpolated resolution 
is not as good as the optical, but it is useful for certain tasks, such as scanning line 
art or enlarging small originals.



Line art
A type of single-bit image that is just purely black and white, such as a pencil or ink 
sketch. Line art may also include one-color images, such as mechanical blueprmts or 
drawings.



Lpi (lines per inch)
The resolution of printed images. Lpi is distinct from dpi, which measures the 
resolution of electronic images.



Midtones
The parts of an image between the lighter and darker areas, at around 50% gray.



Moiré
An undesirable pattern in color printing that results from incorrect screen angles of 
overprinting halftones. Moirés usually result when you scan a halftone or when you 
scan images taken directly from a magazine (instead of scanning a photographic 
original or a transparency).



OCR
Stands for Optical Character Recognition, the process of scanning an image and 
converting the image into text format.



Optical resolution
The true resolution of a scanner and the key factor in determining the amount of 
detail visible in an image. Optical resolution is one type of resolution; the other is 
interpolated resolution.



Pixel
A unit used by the computer to describe picture elements and to represent image 
information in a digital format An image file, for instance, is simply a representation 
of hundreds (or thousands) of pixels arranged in a grid.



Printing methods
The type of printing method you choose should be tailored according to your scanned
image. For instance, low-resolution black-and-white printers are good for producing 
text and line art, but they are not suitable for grayscale. For grayscale images, use 
higher-resolution printers    such as the ones capable of producing 600 to 1200 dpi To 
print color images, you can choose from ink jet/desk jet color printers, dye-
sublimation printers, or    printing presses.



Resolution
The level of detail in an image, expressed in dots per inch or dpi The greater the dpi 
numb<, the higher the resolution and the resulting file size. There are two types of 
resolution: optical resolution, and interpolated resolution.



RGB
The color model in which every color is composed of a varying amount amount of the 
three colors of red, green, and blue.



Saturation
The intensity of a color, or the amount of color in a specific hue. For instance, the 
image of a bright red apple will appear to be "more red" if the colors are saturated.



Scanner
A device that captures an image for your computer and converts it to a digital form 
that your computer can display, edit, store and output A scanner can be used for a 
wide variety of applications, such as incorporating artwork or photos into documents, 
scanning printed text into your word processor to eliminate retyping, scanning faxed 
documents into a database for storage, and adding images to multimedia 
productions.



Scan material
The type of material for your image. Scan materials can be generally classified into 
three types: reflectives, such as photographs or prints; positives, such as slides; and 
negatives, like the negative film used in cameras.



SCSI
Stands for Small Computer System Interface, a format for interfacing hardware to the
computer.



SCSI chain
A chain that links SCSI devices on your system. A SCSI chain may include such 
devices as a scanner, a CD-ROM drive, an external hard drive, and a tape drive. Each 
SCSI device on the chain must have its own SCSI ID number, or conflict will ensue.



Scaling
The process of creating larger of smaller images in ScanWizard, so that the images 
don't have to be resized later when they are delivered to the image-editing program. 
Scaling has an inverse relation to resolution: The lower the resolution, the larger the 
image can be scaled. At the highest resolution, images can only be scaled smaller.



Shadows
The darkest areas of an image.



Single-bit image
The simplest kind of image, using just one bit of data to record each pixel. Single-bit 
images come in two types: line art, and halftone.



Text scanning
One of the most common uses for scanners, as it eliminates the need for retyping. 
Scanners scan text through the use of OCR software and deliver text to your word 
processor.



Terminator
A piece of electrical equipment installed at the end of a SCSI chain. The terminator 
ensures that electrical impulses going through the path are properly routed and 
absorbed. Terminators act as a filter to clear out electrical "noise" caused by multiple 
cables and devices.



Transparent Media Adapter (TMA)
A scanner accessory used for scanning transparencies, slides and filmstrips. The TMA 
has a unique lighting device that prevents transparent originals from being exposed 
to too much light and getting washed out as a result.



Zoom
The ability to magnify the view of an image in the prescan window.
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How to bring up ScanWizard for Windows
To bring up ScanWizard for Windows:
Start up your image-editing software. When the application opens, chose Acquire 
from the File menu, and choose Twain from the submenu.
The very first time that ScanWizard is started up, only the Preview and Settings 
windows will appear. To see the Scan Job and Information windows, go to the View 
menu and choose the Show command for both windows.
The next time you start up ScanWizard, your screen will look exactly like the last time
you exited the software. This means that if you had all four windows open the last 
time you quit ScanWizard, the same four windows will appear the next time you start 
it up.



How to exit ScanWizard
To exit ScanWiz for Windows, double click on the close box on the upper left side of 
the Preview window.



How to select your scanner model
Choose the Scanner Model command from the Scanner menu.
The top of the scanner menu displays the scanner model you're using and its SCSI ID.
If you have multiple scanners on your system, all the scanners are shown with their 
respective SCSI IDs, and the current scanner is indicated by a check.
Only one scanner can be accessed at a time. To switch among various scanners, 
select the scanner to be used.



How to get information the current scanner
Choose the Get Current Scanner Info command from the Scanner menu.
When you choose this command, a dialog box appears showing the scanner model, 
SCSI ID number, and firmware version.



How to use the Preview Setup command and its options
Choose the Preview Setup command from the Preferences menu.
This command allows you to set the dimensions of your preview area. When the 
Preview Setup dialog box comes up, click on the option you need or specify your 
parameters.
For more detail information, see the Preview Setup command.



How to use the rulers
The rulers on both sides of the preview window help you with operations that need 
precise measurement and alignment of your image.
The unit of measurement in the rulers is determined by the unit of measurement you 
have selected. This can be done either in the Image Dimension controls, located in 
the Settings window, or by clicking on the ruler unit button at the 0,0 point of the 
rulers in the Preview window.
Depending on your chosen unit of measurement, the rulers can mark off 
measurement in these units: inch, centimeter, millimeter, point, and pixel. The pixel 
option is dimmed if the selected resolution unit is lip.
To select the unit of measurement for the rulers:
Click on the unit box in the Settings window, or click on the ruler unit button at the 
0,0 point of the rulers in the Preview window. When the submenu appears, select the 
unit of measurement.



How to use the Preview button
The Preview button gives you a preliminary view of the image on your scanner.
Previewing an image gives you greater flexibility, as it allows you to apply various 
controls to the preview image before actually scanning it in. With the preview image 
displayed, you can apply image enhancements or crop the image before performing 
the final scan.



How to use the scan button
The Scan button lets you scan the image in your scanner    and delivers it to your 
image-editing software. The scanned image is based on the specifications you have 
chosen in the Settings window and on controls you may have applied to the preview 
image if a preview was performed.



How to use DCR (Color Correction)
The DCR utility controls the Color Correction feature in the ScanWizard.    DCR comes 
standard on certain scanners; for scanners without DCR, a generic color profile is still 
included    for color correction.    For scanners with DCR then, clicking on the Color 
Correction button will activate DCR. For scanners without DCR, clicking on the Color 
Correction button will activate the generic color profile.
If you have DCR, you need to calibrate your scanner first for the DCR filter to be 
applied when you scan. Otherwise, ScanWizard will simply apply the generic color 
profile for color correction. The calibration process will vary, depending on the type of
scanner you have.
To calibrate color flatbed scanners: 
Place the target that came with the DCR kit face down and upside down on the 
scanner. Center the target along the horizontal ruler of the scanner.
To calibrate transparency scanners (ScanMaker 45t)
Hold the target so that you can read the writing on it, and place it in the transparency
holder. Then slide the holder into the scanner.
To calibrate slide scanners (ScanMaker 35t) 
Hold the target so that the text on the slide reads normally (not backwards), then 
insert the slide into the scanner.
To calibrate color flatbeds with Transparency Media Adapter (TMA) attached
The TMA can be calibrated for either reflective or transmissive mode. Calibrating the 
scanner with TMA for reflective mode allows you to scan photos and prints; 
calibrating the scanner with TMA    for transmissive mode allows you to scan 
transparencies.    Calibrating in both modes enhances your scanner functionality.
To calibrate for reflective mode:
1. Turn off the scanner, then place the 8 1/2" x 14" template that comes with your 

TMA on the scanner glass. The template should be placed snugly within the glass 
area, with no overlapping on the horizontal or vertical rulers of the scanner. When
the template is placed correctly, turn on the scanner. 

2. When the scanner comes to ready, place the reflective target that came with your
DCR kit    inside the template. The target should placed face down    and upside 
down on the scanner, centered along the front edge of the template. 

To calibrate for transmissive mode: 
Do not use the templates, then follow #2 above. Instead of using the reflective 
target, however, you must use the transmissive target that came with your TMA 
package.
To start calibrating: 
1. Launch Windows.
2. Go to the ScanWizard group window, and double-click on the Microtek Calibrator 

icon. 



3. When the Calibrator dialog box opens:
· For color flatbed scanners, click on the Reflective option, then click the Calibrate button.

· For scanners with a TMA, click on the Reflective option if you are calibrating for reflective 
mode; or click on the Transmissive option if you are calibrating for transmissive mode. 
Then click on the Calibrate button. 



How to use the SCSI Check
To use the SCSI Check feature:
1. Choose the Get SCSI Chain command. The SCSI Check dialog box will appear.
2. If your scanner is does not show, click on the Probe button. Make sure your 

scanner is connected an turned on.
3. Make sure the correct interface cad is shown in the card selection box. If not, 

choose the correct interface card.
4. Check the numbered boxes corresponding to the SCSI ID of your scanner (or 

scanners).



How to use the Full Page Preview command
To use the Full Page Preview command:
1. Full Page Preview is the default view. It will be dimmed if the current view is 

already the full page preview. It is available for use only if you are in zoomed 
preview mode. 

2. To change the size of the full page preview, click on the Preview Setup command 
in the Preferences menu. When the Preview Setup dialog box appears, specify the 
new dimensions for the full page preview.

3. To make the new preview dimensions take effect, do a new preview. Click on the 
Preview button, and in a few moments, the new preview area will appear.



How to use the Zoomed Preview command
To use the Zoomed Preview command:
1. Choose the Zoomed Preview command in the View menu. This command is 

available for use if the current view is full page preview. If is disabled if the 
zoomed page preview is not available, or if the current view is already in zoomed 
preview mode.

2. To switch to full page preview again, click on the Full Page Preview command.
For more details on how to use Zoom Preview, refer to the section on the Zoom 
Preview tool.



How to use the Resize Window to Fit command
To use the Resize Window to Fit command:
Choose the command Resize Window to Fit in the View menu. 
This command is available only if the current zoom level is 100%. It is disabled if 
zoom is set to other levels. 



How to use the Show / Hide command
To use the Show / Hide commands:
Choose the correct Show command from the View menu for viewing a window. When 
the window appears, you can hide it by choosing the particular Hide command for it.



How to use the Scan Material command
To use the Scan Material command:
Choose the Scan Material command in the Preferences menu. From the submenu that
appears, select your scan material. A check appears next to the selected option. The 
option you select will also be shown in the Scan Material Status icon.



How to use the Invert command
To use the Invert command:
Choose the Invert command in the Preferences menu. A check appears next to 
command when it is enabled.



How to use the Horizontal Mirror command
To use the Horizontal Mirror command:
Choose the Horizontal Mirror command in the Preferences menu. A check appears 
next to the command when it is enabled.
When the mirror image appears, the scan frame will still be in the old location, and 
you will need to move the scan frame if you wish to define another area.



How to use the Cursor Auxiliary Lines command
To use the Cursor Auxiliary Lines command:
1. Choose the Cursor Auxiliary Lines command in the Preferences menu. From the 

submenu that appears, select how the cursor lines will appear.
· On both x (horizontal) axis and y (vertical) axis
· On axis only
· On axis only
· None (no cursor lines)

2. Click on the Scan Frame tool.
To see how the cursor lines work, draw a scan frame. Click on the top left corner of 
the image as your starting point, then drag down to from a scan frame. As you draw 
the scan frame, cursor lines will appear to help you draw the scan frame precisely. 
When you release the mouse, your scan frame will be aligned with the cursor lines.



How to set the preview area
To set the preview area:
1. Choose an option in the Preview Area drop-down menu. If you enter any of the 

edit boxes marked Top, Left, Width, or Height, the selection in the Preview Area 
menu automatically changes to Custom.

2. Click OK to accept the settings; click Cancel to abandon.
3. To make the new preview dimensions take effect, do a new preview. Click on the 

Preview button, and in a few moments, the new preview area will appear.



How to use the Keep Preview Image command
To use the Keep Preview Image command:
Choose the Keep Preview Image command in the Preferences menu. A check mark    
appears next to the command when it is enabled.



How to use the Smoked Glass Background command
To use the Smoked Glass Background command:
Choose the Smoked Glass Background command in the Preferences menu. A check 
appears next to the command when it is enabled.
For accurate results, make sure you enable the Live Preview option (in the Preview 
Setup command, in the Preferences menu).



How to use the More command
To use the More command:
1. Choose the More command in the Preferences menu. The dialog box appears.
2. Press and hold down the Working Directory box, and from the pop-up menu that 

appears, choose your working directory. 
3. If you click on the folder icon, the Directory Browser dialog box appears. Choose 

your working directory, then click OK to close this dialog box.
Whatever directory you specify is automatically added to the pop-up menu for 
you to choose from in the future. If the directory you specify is not found or does 
not exist, a warning message appears, and the current directory of ScanWizard for
Windows is used instead.

4. When you have completed your choices, click OK to close the More Preferences 
dialog box. For the changes to take effect, exit ScanWizard for Windows, then 
relaunch the program.



How to use the Zoom Preview tool
To use the Zoom Preview tool:
1. Click on the Zoom Preview tool.
2. Move the pointer to the preview image and draw a scan frame around the area to 

be zoomed in.
3. Click inside the scan frame. The selected area will be magnified to give you the 

zoomed preview. Only the area inside the defined scan frame will be zoomed in. 
To zoom in on a larger area, go to full page preview and change the size of the 
scan frame.



How to use the Scan Frame tool
To use the Scan Frame tool:
1. Click on the Scan Frame tool.
2. Move the pointer (now a crossbar) to the preview image, and draw a frame 

enclosing the area to be selected. When you release the mouse, the scan frame 
will be in a marquee.
To make multiple scan frames (which would add scan jobs), hold down the Option 
key and drag the mouse. (For more information on scan jobs, refer to the Scan Job
section.)

3. To resize the scan frame, do either of the following:
· Move the cursor to one of the corners or sides of the frame; the pointer will 

change to a double-headed arrow. Hold down the mouse, and drag to form a 
new area, then release the mouse; or

· Click on the Scan Frame tool again and restart the area-selection process. 



How to use the Magnifying Lens tool
To use the Magnifying Lens tool:
1. Click on the Magnifying Lens tool.
2. Place the pointer -- now a lens with a plus sign inside it -- on the image and click. 

To reduce the view, hold down the Shift key and click again. The plus sign changes
to a minus sign when you hold down the Shift key.



How to use the Hand tool
To use the Hand tool:
1. Click on the Hand tool.
2. Move the pointer (now a hand) to the image. Hold down the mouse and move the 

hand left, right, up, or down, and see portions of the image come into view.



How to use the Color Picker tool
The Color Picker tool allows you to sample color from an area of an image and to 
designate a new shadow or highlight point.
With the Color Picker tool, you can determine the color values for any pixel in an 
image. When you click on the Color Picker tool and pass over a pixel, the value of that
pixel will be displayed in the Information window, based on the samples size also 
selected in the Information window. Pixel-value information is useful especially when 
you're making color adjustments based on color values.



How to change the sample size of the Color Picker
To change the sample size of the Color Picker:
1. Open the Information window by choosing the Show Info Window command in the

View menu.
2. Click on the Sample Size button, located to the right of the RGB values in the 

Information window.
3. Choose your options.

· Select Value or Percent to determine how the pixel information will be 
displayed.

· Select the sample size. For instance, the 1 by 1 option will display the value of 
one pixel -- the one in the middle of the Color Meter Display. The 3 by 3 option 
reads the average value of a 3-pixel by 3-pixel area.



How to display color information for a pixel or an averaged area
To display color information for a pixel or an averaged area:
1. Click on the Color Picker tool.
2. As you pass over a point in the image, see the Information Window the RGB 

values will be displayed in the Color Meter Display. These values are in turn based
on the sample size you selected.



How to select a new shadow or highlight point
To select a new shadow or highlight point:
1. Click on the Color Picker tool, then click on the Window Expansion button to see 

the bottom half of the Settings window.
2. Select a color channel in the channel box.
3. To select a new shadow point, click on a pixel that will serve as the new shadow 

point.
To select a new highlight point, hold down the Shift key as you click; the Color 
Picker tool will change and become a white-colored eyedropper.



How to restore original settings
To restore original settings:
1. Click on the Window Expansion button in the Settings Window to see the bottom 

half of the Settings window.
2. When the expanded window appears, click on the Reset button. When a dialog 

box appears, click on Shadows and Highlights, then click on Reset to close the 
dialog box.



How to use the AIE dialog box
When you click on any of the Image-enhancement tools in the Settings window, the 
Advanced Image Enhance (AIE) dialog box appears. In this box, you can do the 
following:
1. This is where you select the scan job which image enhancement will be applied. 

(Note: For definition of a scan job, see the Scan Job section of the Reference.) If 
you have multiple scan jobs, you can switch among the various jobs, and the 
thumbnails will change accordingly to show the selected scan job.
Important:
Switching to a new scan job while using the AIE dialog box will make any changes 
to the currently selected scan job permanent. This cannot be undone even by 
selecting the Cancel button.

2. These are the thumbnail of the image captured by your scanner. The left 
thumbnail is the "before" version -- which shows the effects of the last saved 
settings values. The "right thumbnail is the "after" version -- which shows the 
effects of the new settings added in the AIE.

3. To select another image-enhancement tool, click on any of the buttons displayed 
in the vertical toolbar on the right side of the dialog box.

4. Click on an action button to achieve a particular effect.



How to use the action buttons in the AIE dialog box
Click on an action button to achieve a particular effect. The Action button in the AIE 
dialog box carry out a specific action. 
The OK button
Clicking on this button will apply whatever image enhancements you have performed
on the current scan job, and close the AIE dialog box. Clicking OK is not the same as 
switching to another scan job (if you have multiple scan jobs). If you switch scan jobs,
the effects are applied to your current scan job, and then the new scan job shows up; 
you do not exit the AIE dialog box.
The Cancel button
Clicking on this button will cancel out all image-enhancement changes you have 
made to the current scan job, and then close the AIE dialog box.
The Reset button
Clicking on this button brings up the Reset dialog box, where you can specify which 
settings are to be reset, then click Reset or Cancel. If Reset is selected, the settings 
are restored to their default values; if Cancel is selected, the operation has no effect.
The Revert button
Clicking on this button cancels out the changes you made with the current image-
enhancement tool. This means that if you used several tools (and achieved a look 
that is the cumulative effect of all the tools), using Revert will cancel the effect of 
only the current tool and preserve the effects of the other preceding tools.



How to use the windows expansion button
The Window Expansion button lets you expand the Settings window to its full size, 
with the bottom half of the window revealing the image-enhancement controls.
When the bottom half of the Settings window is open, you can use the image-
enhancement functions directly by dragging on the slide bar for each control. This is 
like clicking on the image-enhancement tool, which takes you to the Advanced Image
Enhancer (AIE) dialog box where you can change the controls.
Using the slide bars to adjust images may be faster, but using the image-
enhancement tools gives you greater control over adjusting images and shows you 
"before-and-after" images in the AIE dialog box. 
To close the bottom half of the window, click on the Window Expansion button again.



How to use the Type
To use the Type menu:
· From the Type menu select the image type for your final scan. Choose the correct 

image type, as the wrong choice will simple create bigger files that won't be of 
any use to you. For instance, if you have a grayscale original, do not set image 
type to Millions of colors. 

· If you select Halftone, choose the halftone screen as well from the submenu.



How to set Resolution
To set resolution:
Enter a resolution setting in the Resolution edit box. There is no need to press the 
Enter key; typing in a value automatically inputs it into the system. If the value you 
enter is too low or too high, the minimum or maximum resolution value is entered for 
you instead.
Note: In setting resolution, choose the setting that best matches your output device. 
Remember that the higher the resolution, the larger the resulting file will be and the 
longer it will take to output.



How to select the resolution unit
To select the resolution unit:
· Choose dpi if you know precisely the resolution you need for your image. For more

details on resolution, see the Basic Concepts chapter in the manual.
· Choose lpi Draft to produce resolution that is one times the screen frequency (no 

higher than 72 pixels per inch). Draft quality may result in output images that 
look a little blurred or indistinct at edges.

· Choose lpi Medium to produce resolution that is one and one-half times the 
screen frequency.

· Choose lpi Final to produce resolution that is two times the screen frequency.



How to use the Image Dimension controls
To use the Image Dimension controls:
· Select the unit of measurement.
· Enter a value in the applicable edit boxes (width input, height input, scaling, width

output, height output).



How to use the Input-Output dimensions
· Use the input dimensions to specify your scan frame; or simply drag on the scan 

frame to whatever size you want, and the dimensions will be reflected in the input
width and height boxes. Input dimensions can be changed only if the Aspect Lock 
is off

· Use the output dimensions to determine the width and height of your image when
output to an output device such as a monitor or printer. Output dimensions can be
changed only if the Aspect Lock is on.

· Output dimensions are calculated dynamically, and the system looks at other 
variables such as resolution and scaling to determine the final output dimensions.
This means that you may specify output dimensions of 5" x 7", but because of 
intervening variables, the actual output dimensions may be 4.85" x 6.9" -- which 
is the closest the system can produce given your other variables.



How to use the Aspect Lock
The Aspect Lock preserves the ratio of the image width and height from input to 

output. For instance, if you image is 2 inches wide by 4 inches high, changing it to
1 inch by 2 inches will maintain its aspect ratio. Changing it to, say, 1 inch by 4 
inches, however, will alter its aspect ratio, so that the image will be narrower than
the original. 

· If Aspect Lock is ON:
Changing one output edit box (width or height) will automatically change the 
other output field, as well as scaling, to preserve the aspect ratio. With Aspect 
Lock on, you cannot edit the input dimensions.
Important:

· If you change any of the output fields, you must highlight the other output field or
the scaling for the system to change the other output field. The system will then 
make the calculations automatically to preserve the aspect ratio.

· If Aspect Lock is OFF:
Changing one input edit box (width or height) will NOT automatically change 
scaling or the other input field, and aspect ratio can be changed. With Aspect 
Lock off, you cannot change the output dimensions.

To use the Aspect Lock:
Click on the Aspect Lock to lock it; click on it again to unlock.



How to use Scaling
Scaling is the process of creating larger or small images in your scanning software so 
that you need not resize the images later when they are delivered to your image-
editing program.
To illustrate the use of scaling: Assume that your input dimensions are 4" x 5", then:
· If scaling is at 100%, output dimensions will also be 4" x 5".
· If scaling is at 50%, output dimensions will be halved -- to 2" x 2.5".
· If scaling is at 200%, output dimensions will be doubled -- to 8" x 10".
The above assumes that your resolution is held constant throughout the changes. 
When you change resolution and specify a value that has no exact equivalent for 
scaling, the scaling may be affected and adjusts itself to the nearest allowed value. 
For instance, if resolution is 100, scaling becomes 99 (instead of a full 100), because 
that is the closest scaling equivalent, given the resolution value.



How to use the Auto control
To use the Auto control:
1. Click on the Preview button to preview the image. 
2. Click on the Scan Frame tool, and draw a scan frame of the area where Auto will 

be applied. 
3. Click on the Auto button in the Settings window. The button is checked, indicating 

that Auto has been applied. 
If you do not like the results obtained by Auto, or if you choose not to use it for 
certain images that have Auto enabled, click on the Auto button again to deselect
the feature. 



How Auto settings are applied
The Auto setting works by calculating the image settings of the current scan frame 
and applies those settings to the current scan frame.
If you draw a scan frame around part of an image that is light and then apply Auto, 
the part of the image within the scan frame becomes darker. This is because Auto 
takes that dark portion and remaps the pixels to a broader range. The light pixels are 
then spread further apart, resulting in a darker image. 
Conversely, if your scan frame encloses a darker part of the image and then you 
apply Auto, the image part within the scan frame becomes lighter.    The dark pixels 
are remapped to a broader range, resulting in a lighter image. 
When you use Auto, it is helpful to turn on the Smoked Glass Background feature (in 
the Preferences menu in the Preview window). This will allow you to see clearly the 
part of the image within the current scan frame. 



How to use the BCE tool
To use the BCE tool:
1. To change brightness or contrast, choose the Brightness or Contrast control. To 

change values, drag on the slide bar or click on the arrows at either side of the 
bar.

2. To change exposure:
· Click on the Channel box, and select the color channel to be modified. 
· Drag on the Exposure slide bar or click on the arrows on either side of the bar.

3. Click on an action button.
· Click OK to accept the changes and exit the AIE dialog box.
· Click Cancel to abandon all changes and exit the AIE dialog box.
· Click Reset to restore settings to the original default values. 
· Click Revert to cancel the effect of the current image-enhancement tool. 



How to use the Tints Tool
To use the Tints tool:
1. To change the hue of an image, move the pointer in the color wheel to its new 

color position in the wheel.
2. To change the saturation of an image, drag on the saturation slide bar. Dragging 

the slide bar to the left decreases saturation; dragging it to the right increases 
saturation.

3. For negatives only:
· To choose the correct film type for your negative, click on the Film Type 

Selection box and make your selection. If your film type is not in the list, select 
Generic Film Type.

· To correct the exposure of a film, use the Exposure Correction bar. To correct 
overexposure and make the film darker, drag the triangle to the left. To correct 
underexposure and make the film lighter, drag the triangle to the right.

4. Click on an action button.
· Click OK to accept the changes and exit the AIE dialog box.
· Click Cancel to abandon all changes and exit the AIE dialog box.
· Click Reset to restore settings to the original default values. 
· Click Revert to cancel the effect of the current image-enhancement tool. 



How to read and correct a histogram
A histogram shows how the brightness and darkness levels are distributed in an 
image. The darkest pixels are at the left, and the lightest pixels are at the right.
An image with good contrast will have a histogram with vertical lines spread across 
the scale from left to right. To change the histogram (and thus the image), use the 
three triangles below the histogram. 
In the original histogram, the pixels are mostly to the left where the black triangle is, 
indicating a dark image. The range of spread also broad and flat, with almost no 
pixels for the midtones and highlights where the gray an white triangles are.
In the corrected image, the triangles have been moved to new locations. The net 
effect is to narrow the distribution range of the pixels and lighten the image.
Generally, the best thing to do is to move the black and white triangles to the start 
and end of the curve.
For example, if you graph starts at about value 20 and ends at 240, then move the 
black triangle to 20 and the white triangle to 240. Move the gray triangle to 
somewhere in the middle between the black and white triangle.



How to use Shadows and Highlights tool
To use the Shadows and Highlights tool:
1. Choose the channel in which the histogram will be modified.

· Select Master to modify the histogram in the red, green, and blue color 
channels simultaneously.

· Select color channels individually (red, green, blue) to modify the histogram in 
that particular channel.

· For grayscale scanners, only the gray channel is available.
2. Move the black, gray, and white triangles to change shadows, midtones, and 

highlights, respectively. The values in the input edit boxes will change accordingly.
· To make the image darker, move in the black triangle to the right.
· To make the image lighter, move in the white triangle to the left.
· To change the midtones, move in the gray triangle. If the midtone value is less 

than 1, the image will be darker. If the midtone value is greater than 1, the 
image becomes lighter.

3. Click on the Display box to view histograms of the original image and the 
resulting (Enhanced) image.
· Select Original to see the histogram before changes were made to the image.
· Select Enhanced to see the histogram after changes were made to the image.

4. Click on an action button.
· Click OK to accept the changes and exit the AIE dialog box.
· Click Cancel to abandon all changes and exit the AIE dialog box.
· Click Reset to restore settings to the original default values. 
· Click Revert to cancel the effect of the current image-enhancement tool. 



How to read the Curve
The curve shows the relationship of the brightness changes across the middle pixels 
between the resulting image and the original. When you open the Curves dialog box, 
the line on the graph is diagonal because the Input and Output values are the same.
The x axis of the graph represents the original brightness values of the pixels, from o 
to 255; the y axis represents the new brightness values. Clicking on the diagonal line 
then plots a point that can be adjusted.
When the curve is moved up or down, the relationship between input value and 
output value changes accordingly.
· In areas where the curve is moved down, pixels in that portion of the image are 

darkened.
· In areas where the curve is moved up, pixels in that portion of the image are 

lightened.
Contrast in an image can be seen by the angle of the line. The steeper the slope. the 
higher the contrast. The closer the line is to horizontal, the lower the contrast.



How to use the Curve tool
To use the Curve tool:
1. Choose the channel in which the curve will be modified.

· Select Master to modify gamma in the red, green, and blue color channels of 
the image simultaneously.

· Select color channels individually (red, green, blue) to modify gamma in that 
particular color channel.

· For grayscale scanners, only the gray channel is available.
2. Choose the Method in which the curve will be modified; select from Line, Curve, or

Gamma. There is no difference in the method you select, and the choices are 
provided to give you more flexibility in adjusting the curve.

3. Choose a curve button; select from Pointer, Zoom Frame, or Hand.
· Use the Pointer button to define points in the curve that will be modified. When

you click on any point in the curve, a control point appears to mark your 
position. To remove a control point, drag it off the graph.

· Use the Zoom Frame button to zoom in on a particular point in the curve. Once
the area is zoomed in, you can then use the pointer tool to define new points 
for more precision. This is particularly useful for working with 12-bit images, as 
more detail can be seen in such images. The zoom level can be seen in the 
Zoom column.

· Use the Hand tool to scroll through the curve if the curve has been zoomed in. 
The Hand tool can be used only if the curve has been zoomed in with the Zoom
Frame button (above). Otherwise, the Hand tool will be dimmed.

4. Click on the curve to define the points where the curve will be modified.
Once you click on a point in the curve, a control point appears to mark your 
position. You can then either raise or lower the curve at that point and see 
changes to the image accordingly. 

5. Click on an action button.
· Click OK to accept the changes and exit the AIE dialog box.
· Click Cancel to abandon all changes and exit the AIE dialog box.
· Click Reset to restore settings to the original default values. 
· Click Revert to cancel the effect of the current image-enhancement tool. 

6. To save a curve, click on the Save button. A dialog box will appear.
· Save the curve in Microtek format. The Microtek format allows you to have as 

many as 64 control points in the curve for more precision.
· Choose the Channel. Select All if your channel is Master, select Current if you 

selected one of the three color channels (red, green or blue).
To use a previously saved gamma curve for another image, click on the Load button, 
then specify the curve to be loaded. Photoshop-saved curves can also be loaded.



How to use the Curve buttons
The Curve buttons allow you to modify the curve in the Curve dialog box. 
· Use the Pointer button to define points in the curve that will be modified. When 

you click on any point in the curve, a control point appears to mark your position. 
To remove a control point, drag it off the graph.

· Use the Zoom Frame button to zoom in on a particular point in the curve. Once 
the area is zoomed in, you can then use the pointer tool to define new points for 
more precision. This is particularly useful for working with 12-bit images, as more 
detail can be seen in such images. The zoom level can be seen in the Zoom 
column.

· Use the Hand tool to scroll through the curve if the curve has been zoomed in. 
The Hand tool can be used only if the curve has been zoomed in with the Zoom 
Frame button (above). Otherwise, the Hand tool will be dimmed.



How to use the Filters tool
To use the Filters tool:
1. Click on the Filters tool in the Settings window. When the Advanced Image 

Enhancer dialog box appears, click on the Filter box, and from the drop-down 
menu that appears, select the filter to be used. 

2. Click on an action button.
· Click OK to accept the changes and exit the AIE dialog box.
· Click Cancel to abandon all changes and exit the AIE dialog box.
· Click Reset to restore settings to the original default values. 
· Click Revert to cancel the effect of the current image-enhancement tool. 

3. To preview filters and see their effects immediately, click on the box Show Filter 
Effect on Preview Image.



How to use Unsharp Masking
1. Choose Unsharp Masking from Filters menu. The Unsharp Mask dialog box 

appears.
2. Enter a value in the Amount box to specify the percentage of the filter's effect. 

The higher the percentage, the stronger the effect of the filter.
3. Enter the Radius value in pixels. The radius determines the depth of pixels that 

will be affected at the edge.
· With a high value, more of the pixels surrounding the edge pixels are sharpened.

· With a low value, only the edges are sharpened.

4. Enter a value in the Threshold box.
This option allows you to specify a tolerance range to prevent overall sharpening 
that might generate noise or cause other unexpected results.
The Threshold defines the required range of contrast between adjacent pixels 
before sharpening is applied to an edge. A lower value produces a more 
pronounced effect.



How to use the Gray Scan CCD Filter
This option allows you to select a particular color channel when scanning grayscale 
images and is useful for obtaining certain effects.
When scanning grayscale images, one of the color channels of the CCD can be used 
scanning; this could be the red, green, or blue color channel.



How to use the Scan Quality
This option allows you to select the quality of your scans. 
Choose Draft if you're outputting images as drafts. This option speeds up the 
scanning process, but the image may be a little coarse (compared to the Final 
option).
Choose Final if you wish to have a scanned image of better quality. This option, 
however, is slower than Draft.



How to use the Linear Gamma Curve
This option allows the scanning software to read only raw image data, so that no 
color adjustment (not even the generic color correction profile) is applied to your 
image when it is scanned.
This control is helpful for professional graphic designers who wish to create very 
specific effects and are thoroughly familiar with the scanning process. If you are not 
familiar with this feature, leave this option turned off.



How to use Descreen
To use Descreen:
1. Click on the More Options tool in the Settings window.
2. When the More Options screen comes up, click on the Descreen box and select 

your descreen option. The option you select will depend on the dot quality of the 
original.
· Choose Newspaper if the original image has a coarse dot pattern (like images 

in a newspaper).
· Choose Magazine for images with a finer dot pattern.
· Choose Art Magazine for images with near-photographic quality with a very 

tight dot pattern.
· Choose Custom for customized descreen options. 
A check appears next to the descreen option that is enabled.
Note: Because of the nature of this filter, scans may take longer if you use the 
Descreen feature



How to use Velocity
To use Velocity:
Click on the More Options tool. When the dialog box comes up, click on the Velocity 
box and select your scanning speed 
Important:
Sometimes certain scanner models on certain configurations appear to make noise 
when scanning. This could be normal and may be related to the speed at which the 
carriage is moving. Changing the velocity can change the amount of noise or type of 
sound made by the scanner. The action of previewing and scanning can also generate
different noises, but this is no cause for alarm.



How to use the controls in the More Options tool
Click on the More Options tool in the Settings window. When the More Options screen 
appears, select the particular control to be modified and its option, then click OK.



How to read the Scan Job window
1. The example show three scan jobs. 

· The first scan job, entitled Default Scan #1, is a color image.
· The second scan job, entitled Default Scan #2, is a color image.
· The third scan job, entitled Default Scan #3,  is a duplicate that shares the 

settings of the second scan job.
The current scan job is the first scan job (Default Scan #1), which is highlighted to
mark it as the current scan job. All three scan jobs will be scanned, as each is 
marked with a check. To change the order in which the jobs will be scanned, use 
the up and down position arrows to change the sequence of the titles.

2. The image-type icon in front of the scan job title shows the scan job type -- 
whether it is color, grayscale, line art, or halftone. A color scan job will have a 
color image-type icon; a grayscale scan job will have a gray image-type icon; and 
a line art or halftone scan job will have its corresponding image-type icon.



How to use the New button
To use the New button:
1. Click on the Preview button to see a preliminary view of the image.
2. When the preview image appears, draw a scan frame that covers the left half of 

the image. At this time, your scan job area shows the title of the current scan job 
(Default Scan #1. Make sure the image type selected (in the Settings window) for 
this scan job is Millions of colors.

3. Click on the New button in the Scan Job window. When a dialog box comes up, 
give a title to the new scan job, then click OK. In this example, the new scan job is
called Default Scan #2. The Scan Job window will now have two titles. At the same
time, a new frame appears in the preview window.

4. Draw the second scan frame around the right half of the image. In this case, 
confine the scan frame to the upper right half; leave the lower right half free. The 
reason why will become apparent in the next step. 

5. With the title bar in the Scan Job window highlighting the second scan job, go to 
the Settings window, then choose 256 shades of gray in the Type box. Next, go to 
the Preferences menu in the Preview window and enable the Smoked Glass 
Background command.
You will now see the following:
· The second scan job (the upper right half of your image) is in grayscale.
· The first scan job (the left half of the image) remains in color.
· The lower right half of the image (the part not included in any scan frame) is 

hidden behind the smoked glass background. The smoked glass command is 
not essential for doing a scan job, but it helps you distinguish scan frames 
more easily.

6. To see how the scan jobs relate to the titles in the Scan Job window, try this.
· Click on the first scan job title. The scan job that becomes active will be the left

half of the image (in color). In the Scan job window, the title will be highlighted,
indicating that it is the current scan job.

· Click on the second title, and the second scan job is activated (upper right-
hand part of image, in grayscale). The second title is now highlighted, because 
it is the current scan job.

7. To designate the scan job to be processed and scanned, select the scan job and 
click on the Check button. The checked scan job(s) will then be scanned in the 
order that they appear in the Scan Job window, and they will be delivered 
separately to your image-editing software. 



How to use the Duplicate button
To use the Duplicate button:
1. Click on the Preview button to see a preliminary view of the image. To show the 

principle of duplication clearly, choose image type (in the Settings window) as 
Millions of colors. Also turn on the Smoked Glass Background feature (in the 
Preferences menu of the Preview window). 

2. Draw a scan frame around a part of the image. This is your current scan job.
3. To see the effects of duplication clearly in the steps that follow, set the image 

type of the current scan job to 256 Grayscale. You will see the current scan job as 
a grayscale job, while the rest of the image behind the smoked glass background 
remains in color.

4. Click on the Dup button. Draw another scan frame around a different part of the 
image; this is your duplicate scan job. You will see that the duplicate scan job will 
also be in grayscale, as it shares the settings of the current scan job. In the Scan 
Job window, there will be two titles, and the duplicate scan job is the one with a 
number to it.

Shortcut to creating duplicate scan jobs:
Hold down the Shift key and dray the mouse. A duplicate scan job is created based on
the current scan job, and a duplicate title is added in the Scan Job window.



How to use the Save button
To use the Save button:
1. Click on the Save button.
2. When a dialog box appears, give a name to the scan job template to be saved, 

then click OK



How to use the Add button
To use the Add button:
1. Click on the Add button.
2. When a dialog box appears, specify the name of the scan job template to be 

added, then click Add. To close the dialog box, click Close.



How to use the Check button
To use the Check button:
1. In the Title area of the Scan Job window, select the scan job to be scanned.
2. Click on the Check button. A check will appear next to the selected scan job.
3. To uncheck a selection, select the scan job to be unchecked, and click on the 

Check button again. The scan job will be unchecked, and the scan job will not be 
scanned when you click on the Scan button.



How to use the Delete button
To use the Delete button:
1. In the Title area of the Scan Job window, select the scan job to be deleted.
2. Click on the Del button. The scan job is deleted.



How to use the Up/Down position arrow buttons
To use the Up/Down position arrows: 
1. In the Title area of the Scan Job window, select the scan job to be moved up or 

down.
2. Click on the Up or Down arrow to change the order of the scan job in the list. 

When you start scanning, the scan jobs will be processed and scanned in the 
order that they appear in the Scan Job window.



How to use the Zoom Level Display
To use the Zoom Level Display:
Click on the Zoom Level box. From the drop-down menu that appears, select your 
zoom or magnification level.



How to use the Cursor Locator
The Cursor Locator shows you where the cursor is on the x (horizontal) and y 
(vertical) coordinates of the axis. This feature is useful for operations that require 
very precise measurements and alignment. 



How to use the Color Meter Display
The Color Meter Display is useful if you wish to adjust the shadow and highlight 
points of an image.
As you pass over a point in the image, the Color Meter Display will show the 
appropriate RGB values of that point in the image. 



How to use the Sample Size button
The Sample Size button provides options for choosing how extensively the color 
information will be read whether the color information will apply to a pixel, a    2-pixel 
by 2-pixel area, or a wider expanse (maximum 5-pixel by 5-pixel area).
When you click on the Sample Size button, the drop-down menu appears.



How to use the Pixel Display
The Pixel Display helps you see how color pixels are organized and distributed. The 
display can then help you make an informed judgment on how best to modify image 
characteristics such as    shadows and highlights, and also allow you to verify any 
changes that are made.



Troubleshooting
1. If the POWER indicator fails to light up
2. The scanner's READY light does not come on; you do not have a Transparent 

Media Adapter
3. The scanner's READY light does not come on; you have a Transparent Media 

Adapter. (Also see troubleshooting tip #13.)
4. When issuing a Scan command, the software locks up after the scanner seems

to start scanning (makes "noises"); or you get an error message
5. When you scan an 8-1/2-inch wide image, the left or right side of the image is 

cut off
6. The scanner makes loud noises when scanning
7. While scanning images, the scanner carriage (lamp) keeps going back and 

forth, or idles , resulting in very long scan times
8. Your scanned images do not have the same color as the original
9. Scanned images have vertical white lines from top to bottom
10. When you select Acquire, the Microtek scanner software reports that no 

scanner is connected, or the Scan and Preview buttons are grayed out
11. The Photoshop File-Acquire option is grayed out, and you cannot select the 

option for your Microtek scanner
12. Color images are washed out with little detail in the light or highlight areas
13. Color images seem to have a pattern on them when scanned
14. Problems with the Transparent Media Adapter (TMA)
15. The Color Correction button is grayed out and you cannot select it
16. When you preview or scan, the scanner will not move, but an image appears 

in the software as if the scanner was working
17. The options billions of colors and 1000s of shades of gray are grayed out 
18. You are not able to select different media types such as negative or positive 

transparency from the Scan Material command (in the Preferences menu of the Preview 
window)

19. You are unable to use the Auto Document Feeder (ADF)
20. You get this message: "Kodak Precision CMS not found or there is insufficient 

memory to initialize it..."
21. The KCMS Acquire option is not present



1. If the POWER indicator fails to light up
Solution:
Turn off the scanner. Make sure the scanner's power is grounded and plugged into an 
AC outlet. Wait 60 seconds, then turn on the power again. Microtek scanners have a 
protective mechanism that prevents the scanner from coming on right away after it's 
just been turned off to increase the life of the power supply.



2. The scanner's READY light does not come on; you do not have a 
Transparent Media Adapter.

Solution:
Check the fluorescent lamp inside the scanner and make sure it is continuously and 
solidly on. Take note of the following:
· If the lamp is on and the scanner still doesn't come ready, the problem may be 

related to temperature. For example, you may experience problems of this sort if 
you live in cold weather and the scanner is left in a room all night without the 
room's heater on.
To resolve this situation, leave the scanner on for 30 minutes to warm up, then 
turn it off and back on after 60 seconds, and see if you get a steady READY light 
this time.

· If the lamp still doesn't come ready, do one of the following:
a) If you purchased your scanner within the past 30 days, call your dealer.
b) If your purchased your scanner more than 30 days ago, call the nearest service

center or Microtek directly.
If your lamp is on and the READY light is on but the scanner doesn't scan or doesn't 
seem to work, try testing the scanner to see if it is a scanner-related hardware 
problem. To do this, disconnect the scanner from the computer, set the SCSI ID to #7,
and turn it on. The scanner will scan continuously. If it does not, there is a hardware 
problem. Contact your dealer and tell them the situation.



3. The scanner's READY light does not come on; you have a Transparent 
Media Adapter attached. (Also see troubleshooting tip #13.)

Solution: 
Disconnect the Transparent Media Adapter (TMA) and see if the scanner comes ready 
this time. If not, see the solution outlined in situation #2.
If the scanner comes ready on its own but doesn't come ready if attached to the TMA,
you may have a problem with the gray template that comes with the TMA, or you 
may have a problem with the external power supply.
To resolve this situation, check the following:
· Make sure you have an external power supply (included with the TMA if needed) if

your scanner model (such as the ScanMaker IISP) requires one. The power supply 
is needed for the TMA to function.

· Make sure the TMA model matches your scanner (check the outside of the TMA 
box to verify this). If you have the wrong or mismatched TMA model, call your 
dealer and exchange it for the correct one.

· Next, install the TMA (and the power supply if it has one), and close the TMA top. 
Make sure that nothing is placed inside the scanner on the glass surface and then 
turn the scanner on. You should now get a ready light.

If your lamp is on and the READY light is on but the scanner doesn't scan or doesn't 
seem to work, try testing the scanner to see if it is a scanner-related hardware 
problem. To do This, disconnect the scanner from the computer, set the SCSI ID to 
#7, and turn it on. The scanner will scan continuously. If it does not, there is a 
hardware problem. Contact your dealer and tell them the situation.



4. When issuing a Scan command, the software locks up after the scanner 
seems to start scanning (make "noises"); or you get an error message.

4A. If you have the Transparent Media Adapter:
Make sure the TMA is installed properly (see situation #3 for more details). In 
addition, make sure you observe the following:
· Place the gray template that comes with the TMA on the glass surface of the 

scanner, with the clear opening of the template towards the front of the 
scanner.

· Place the transparency to be scanned inside the template, and close the cover.
· In the scanning software, select either Positive or Negative from the Scan 

Material command in the Preferences menu (depending on whether you're 
scanning a positive or negative transparency); do not use the Reflective 
option.

· After complying with the above, click on Scan or Preview.



5. When you scan an 8-1/2-inch wide image, the left or right side of the 
image is cut off.

Solution:
This may happen if you are using a ScanMaker III scanner, which has a maximum 
scanning width of 8.3 inches. Therefore, a small margin on each side will be cut off 
when you scan.



6. The scanner makes loud noises when scanning.
Solution:
Certain scanner models make different noises when scanning. The noise results from 
the mechanical parts moving at various speeds, depending on your configuration, so 
some systems have more noise while others have less. The noise is greatest when 
the velocity is set to Fast or Auto. To resolve this, set the velocity in the scanning 
software (in the More Options tool in the Settings window) to Medium or Slow to 
reduce the noise.



7. While scanning images, the scanner carriage (lamp) keeps going back 
and forth or idles, resulting in very long scan times.

Solution:
This is called backtracking. Microtek scanners have a feature that allows for recovery 
from image defects that result from the carriage scanning and stopping during the 
scan. The carriage usually goes back and reads part of the image once, then goes 
back a second time to patch the images together and create a smooth picture. On 
some machines, due to low amount of memory or a large virtual memory size, the 
software forces the scanner to stop and start too many times, causing backtracking.
To resolve this, you can:
· Increase RAM in the computer by purchasing more memory.
· Reduce or turn off virtual memory in the Windows 386 Enhanced module inside 

the Main group window. 
· If using the Omnipage Direct software, turn off the Auto Intensity feature under 

the Options menu.



8. Your scanned images do not have the same color as the original. 
Solution:
Generally, scanners, monitors, and printers all see and output color differently. In 
order to come close the original colors, you need to calibrate all three devices. 
Microtek 's DCR color correction system ensures that your scanner capture colors 
accurately, but to have these colors output correctly to a monitor or printer, you need
a color management system such as Kodak's Color Management Software, or AGFA's 
Color Calibration System. These third-party color management systems ensure color 
Integrity throughout the color production process from input to output. Usually, all 
scanners scan a little darker or lighter than the original (for instance, a scanner may 
scan red as magenta). This is not a fault of the scanner but a situation inherent to 
calibration of the equipment.



9. Scanned images have vertical white lines from top to bottom.
Solution:
The mirrors of your scanner may be dusty or dirty. To resolve this, open the cover and
spray some air on the bottom mirror which is roughly 8-1/2" long and is directly below
the carriage (but moves with the carriage). Do not clean the mirrors with glass 
cleaners such as Windex or with cloth. If you want to use a liquid, use alcohol and 
lens tissue paper (other materials may scratch).



10.When you select Acquire, the Microtek scanner software reports that no 
scanner is connected, or the Scan and Preview buttons are grayed out.

Solution: 
This problem usually happens when the software cannot see the scanner. This 
situation could be resolved by any of the following:
· Make sure the scanner has a solid green light on and that the lamp inside is 

continuously and solidly on (no flickering). If not, see troubleshooting for situation 
#2.

· Make sure the scanner is connected properly to the computer. If you have 
multiple SCSI devices connected to your computer, try the computer with only the
scanner connected to see if the two work. If they do, the problem is with another 
SCSI device or with the cabling. Make sure none of your cables are too long (4 
feet or shorter), and make sure the last SCSI device on your system is externally 
terminated with a terminator.

· Set the Windows display option to VGA or super VGA, then restart Windows and 
try again. The problem may be a conflict with the video driver.

· Turn off 32-bit addressing in the 386 Enhanced module of the Main group window, 
then restart Windows and try again. 

· Make sure the SCSI ID setting on your scanner is unique, and that no other SCSI 
device has the same setting as your scanner. Microtek scanners are set to SCSI ID
#6 by default. If you have a utility that can scan your SCSI bus (such as 
ScanWizard's      SCSI Check feature), you can easily find out what ID numbers are 
taken and which ones are free to be used for the scanner.

· You may also want to try to scan using the Scanner Test utility to see if the 
problem is in your image-editing software or due to other conflicts between the 
software and another program in your computer. If the test utility works, then 
your scanner is operating properly, and you can then look for other utilities and 
programs that may be causing the problem.



11.The Photoshop File-Acquire option is grayed out, and you cannot select 
the option for your Microtek scanner.

Solution:
When you installed Photoshop, you installed for minimum configuration and did not 
install the Plug-ins option. You need to reinstall Photoshop, and during installation, 
you must specify that the Plug-ins are to be installed as well. 



12.Color images are washed out with little detail in the light or highlight 
areas.

Solution:
Sometimes on certain images that are light, enabling the Color Correction option or 
the Auto button (both in the Settings window) might make the images very light and 
thus cause certain areas to wash out. To resolve this, you may want to turn off these 
options. 
Also, if you are scanning very light highlight areas and they're coming out white, try 
reducing the exposure control (through the Brightness, Contrast and Exposure tool) to
a negative number.



13 Color images seem to have a pattern on them when scanned.
Solution:
Check the following:
· Make sure that your monitor option in your Windows setup is set to 16.7 Millions 

of colors. 
· If you scan an image that came from a magazine or brochure, you will get an 

artifact on the image called moiré. Moiré patterns show up when you Scan an 
image that has been printed already. To reduce the patterns, select the More 
Options tool in the Settings window, and then select the Descreen filter. In the 
Descreen filter are options for newspaper, magazine, art magazine, and custom. 
For more details, refer to the Reference section in the manual.



14.Problems with the Transparent Media Adapter (TMA)
Solution: 
Check the following:
· If you have a ScanMaker II scanner, make sure your TMA is of a matching model 

(TMA for the ScanMaker II). If not, call your dealer and exchange the TMA for the 
correct one. Also, older ScanMaker ll scanners may not work with the TMA unless 
you upgrade the board inside the scanner. Take note of the following:
1. If the serial number on your scanner is above S2B5720701 or below, call 

Microtek to arrange for a scanner upgrade; the upgrade costs $350.
2. If the serial number on your scanner is above S2B5720701 (ex. S2B5720702), 

your scanner needs to have Firmware version 5.61. The firmware version of 
your scanner is marked on the scanner box as F/W: version number . If you do 
not have firmware version 5.61 or higher, you need to replace the chip inside 
your scanner with the one provided in the TMA box. 

· If you have a ScanMaker IISP scanner, make sure your TMA is of a matching model
(TMA for the ScanMaker lISP). If not, call your dealer and exchange the TMA for 
the correct one. In addition, make sure an external power supply was provided 
with the TMA in the TMA package, and connect the power supply to the scanner 
for the TMA to operate properly .

· If you have a ScanMaker III scanner, make sure the TMA cable is connected on the
back of the ScanMaker III scanner and that the screws are very tight. Otherwise, it
is possible that the TMA may not work.

· See #18.



15.The Color Correction button is grayed out and you cannot select it.
Solution:
This button turns gray when the DCR or Dynamic Color Rendition files are missing 
from the Windows/Twain/Microtek/DCR directory. To fix this problem, run the calibrator
program and calibrate your scanner, or reinstall the ScanWizard so that the default 
profiles are copied onto your system.    A new set of profiles will then be generated.



16.When you prescan or scan, the scanner will not move an image appears 
in the software as if the scanner was working.

Solution:
This problem may be due to the scanner selection under the scanner pull-down menu
in the Preview window. If you select ScanMaker Demo, the program will go through all
the motions of scanning an image, but it will use a sample image file instead of the 
scanner as the source. To fix this problem, select your scanner model from the 
Scanner menu. This will change the source from the sample image file to scanner. If 
no scanner model appears in the Scanner menu, you may have a communication 
problem with your scanner. See troubleshooting tip #10.



17.The options billions of colors and 1000s of shades of gray are grayed 
out.

Solution:
These two options are available only with the ScanMaker III. The option billions of 
colors is a mode in which you scan 67.8 billion colors, and this requires a 36-bit 
scanner like the ScanMaker III. The option 1000s of shades of gray is 12-bit 
(equivalent to 4,096 shades of gray) and is also available only through a 12-bit-per 
channel scanner like the ScanMaker III. These options can be used only if your 
application supports them (Photoshop 3.0 does; others may not).



18.You are not able to select different media types such as negative or 
positive transparency from the Scan Material command 

Solution:
Your Transparent Media Adapter (TMA) may be faulty, or it may not be connected to 
the scanner properly.
· If you have a ScanMaker III, make sure the screws on the transparency connector 

cable are in firmly and screwed tightly to ensure proper connection. If you just 
plug the cable to the back of the ScanMaker III or simply tighten the screws a little
bit, you won't get a good connection.

· If you have a ScanMaker IISP, make sure the external power supply for the TMA is 
connected to the scanner. If you did not get an external power supply with your 
TMA, you have received the wrong TMA. Contact the place where you purchased 
the TMA for an exchange. For verification, look at the TMA box; it should say 
"Transparency Adapter for the ScanMaker IISP scanner."



19.You are unable to use the Auto Document Feeder (ADF)
Solution:
Take note of the following:
· This problem may occur if your ADF is not properly installed. If you have a 

ScanMaker IISP scanner, make sure you have the external power supply 
connected to the back of the scanner. If you did not get an external power supply,
contact the place where you purchased the ADF for an exchange. For verification, 
look at the ADF box; it should say "Auto Document Feeder for the ScanMaker IISP 
scanner."

· Also, if you attempt to scan color images through the ADF, you will not able to do 
so because the ADF only supports multiple page-scanning for line-art, halftone, 
and grayscale, but not color.

· Maker sure too that your application supports multiple-page scanning. Some 
graphics applications can only support one document at a time.



20.You get the message: "Kodak Precision CMS not found or there is 
insufficient memory to initialize it.."

Solution:
You may need to reinstall Photoshop and select the Photo CD option (aside from 
installing the Photoshop program itself and the Plug-ins option, both of which are 
necessary.)



21.The KCMS Acquire option is not present.
Solution:
This option is available only in Photoshop, and you will not be able to use it in other 
image-editing applications.



The Scan Job Window
The Scan Job window is an important feature of the scanning software and provides 
several key functions in processing your scans.

A scan job is simply a task that you designate the scanner to process and scan. For 
instance, when you first preview an image, the image as a whole has its own 
parameters (its own brightness and contrast setting, resolution, etc.). The whole 
image can be treated as one scan job, or you can select a part of the image, apply 
different parameters to it, and treat that as a separate scan job. Scan Job 1 can be in 
color mode, while scan job 2 can be in grayscale mode.
By making the scan jobs distinct, you can then process each job separately (apply 
image-enhancement, change settings, etc.) and scan them as separate files into your
image-editing software (if the software supports multiple open images).
The number of scan job is indicated by the number of titles in the Scan Job window. 
Scan jobs marked with a check are the ones designated to be scanned, and the jobs 
are scanned in the order that they appear in the window.
How to read the Scan Job window 



Title area
The Title area shows the number of jobs that have been created. In this example, 
there are two scan jobs. Check marks indicate which job or jobs are to be scanned; 
the highlighted title indicates the current scan job. To rename a scan job, double click 
on the title and type over a new name.



The New button 
The New button Iets you create a new scan job; the new scan job will have default 
settings. This feature allows you to create as many scan jobs as you wish, and each 
scan job can then have its own settings. 
How to use the New button 



The Duplicate button
The duplicate button lets you duplicate the settings of a scan job. This function is 
especially helpful if you have created optimal settings for a scan job and wish to use 
these settings as a template for other scan jobs. This saves time, as you don't have 
to create the settings repeatedly for every scan job you make
Before using Duplicate, it is helpful to turn on the Smoked Glass Background feature. 
This will allow you to see clearly the effects of duplication.
To use the Duplicate button



The Save button
The Save button lets you save the settings in a scan job to a scan job template that 
can be used for future scan jobs.
To use the Save button:
1. Click on the Save button.
2. When a dialog box appears, give a name to the scan job template to be saved, 

then click OK.



The Add button 
The Add button lets you add a scan job from a scan job template saved previously. 
To use the Add button:
1. Click on the Add button.
2. When a dialog box appears, specify the name of the scan job template to be 

added, then click Add. To close the dialog box, click Close.



The Check button 
The Check button allows you to select the scan jobs to be scanned. When you then 
click on the Scan button to start scanning, the scan jobs marked by a check are the 
ones that will be scanned. The Check button is a toggle.
To use the Check button:
1. In the Title area of the Scan Job window, select the scan job to be scanned.
2. Click on the Check button. A check will appear next to the selected scan job.
3. To uncheck a selection, select the scan job to be unchecked, and click on the 

Check button again. The scan job will be unchecked, and the scan job will not be 
scanned when you click on the Scan button.



The Delete button 
The Delete button lets you delete a scan job from the list.
To use the Delete button:
1. In the Title area of the Scan Job window, select the scan job to be deleted.
2. Click on the Del button. The scan job is deleted.



The Up/Down Position Arrows 
The Up/Down position arrows allow you to change the sequence in which the jobs are 
scanned through changing the order of the scan jobs in the Title area.
To use the Up/Down position arrows:
1. In the Title area of the Scan Job window, select the scan job to be moved up or 

down.
2. Click on the Up or Down arrow to change the order of the scan job in the list. 

When you start scanning, the scan jobs will be processed and scanned in the 
order that they appear in the Scan Job window (i.e., the first scan job is scanned 
first; the second scan job is scanned, etc.).



The Information Window
The Information window provides information on the cursor and the preview image. It 
also allows you to change zoom levels directly, in much the same way like using the 
Magnifying Lens tool in the Preview window.

The Information window is a "floating window" and does not appear when you start 
up the scanning software. To display the information window, click on the Show Info 
window command in the View menu (in the Preview window).



Zoom Level Display
The Zoom Level Display magnifies your view of an image, much like the Magnifying 
Lens tool in the Preview window.
The magnification factor in both Zoom Level Display and the Magnifying Lens tool is 
by a factor of 2. Thus, the magnification levels increase from 100% to 200%, to 
400%, and to the maximum 800%.
To use the Zoom Level Display:
Click on the Zoom Level box. From the drop-down menu that appears, select your 
zoom or magnification level.



Cursor Locator
The Cursor Locator shows you where the cursor is on the x (horizontal) and y 
(vertical) coordinates of the axis. This feature is useful for operations that require 
very precise measurements and alignment. 



Color Meter Display
The Color Meter Display is useful if you wish to adjust the shadow and highlight point 
of an image.
As you pass over a point in the image, the Color Meter Display will show the 
appropriate RGB values of that point in the image. The significance of the numbers is 
explained below. 
· The numbers in the Color Meter Display represent color information taken by the 

scanner. The values can be anywhere from o to 255, with 0 as the black point, 
255 as pure white, and all other values in between corresponding to shades from 
black to white. 

· The values as a whole represent color information for the sample size selected in 
the Sample Size button. For instance, if you chose 3 x 3 as your sample size and 
your R value reads 23, that shows your red value of 23 is the average of a 3-pixel 
area.

Pixel-value information is useful especially if you are making color corrections based 
on color values. Knowing this, you can modify the shadow and highlight points of an 
image, then come back to the same point in the image, and verify through the Color 
Meter Display that the RGB values have indeed changed.
The Color Meter Display can also be used in conjunction with the Color Picker tool. 



Sample Size button
The Sample Size button provides options for choosing how extensively the color 
information will be read whether the color information will apply to a pixel, a 2-pixel 
by 2-pixel area, or a wider expanse (maximum 5-pixel by 5-pixel area).
When you click on the Sample Size button, the drop-down menu below appears:



Value
If you choose Value, the numbers in the Color Meter Display represent the value in 
the 0-to-255 pixel scale. For instance, an R value of 23 indicates that the sampling 
size selected has a red color value of 23. Value is calculated by multiplying the 
percentage by the constant 255 (value = 255 x percent).



Percent
If you choose Percent, the numbers represent the percentage of the maximum 
intensity of the pixel. For instance, a G value of 35% indicates that    the sampling size
selected has a green color value to be 35 percent intense (out of 100 percent). 
Percent is calculated by dividing the constant 255 by the value (percent = 255 / 
value).



Sample Size Options
This determines the expanse of color information to be made available. For instance, 
if you choose 5 x 5 as your sample area, this means your RGB values will represent 
color information for a 5-pixel by 5-pixel area. If you choose 1 x 1, the color 
information pertains to a single pixel -- the one in the middle of the Pixel Display.



The Pixel Display
The Pixel Display helps you see how color pixels are organized and distributed. The 
display can then help you make an informed judgment on how best to modify image 
characteristics such as shadows and highlights, and also allow you to verify any 
changes that are made.



The Preview Window
The Preview window is the most prominent window of the four major windows, and it 
includes the various commands and tools for controlling the scanner.



The Menu Bar
The Menu bar includes the different menus for setting up the scanner (Scanner 
menu), controlling view options (View menu), customizing the software (Preferences 
menu), and accessing onlne help (Help menu).



The Scanner Menu

The Scanner Menu lets you:
· Show your scanner model or select the current scanner if you have multiple 

scanners 
· Get information about your scanner
· Get information about the SCSI chain



Scan Model
The top of the scanner menu displays the scanner model you're using together with 
its SCSI ID. If you have multiple scanners on your system, all the scanners are shown 
with their respective SCSI IDs, and the current scanner is indicated by a check. 
Only one scanner can be accessed at a time. To switch among various scanners, 
select the scanner to be used. 



Get Current Scanner Info
This command provides information about your current scanner and displays a dialog 
box that shows the scanner model, SCSI ID number, and firmware version.



Get SCSI Chain Info
This command allows you to see the SCSI devices on your SCSI chain, particularly 
your scanner, as well the SCSI ID number of the devices.
By default, all numbers are selected by the check boxes. To allow ScanWizard for 
Windows to start up more quickly, select only the boxes that match the SCSI ID of 
your scanner (or scanners, if you have multiple scanners on your system). This will 
make the ScanWizard bypass the numbers for your other devices and focus effort on 
simply detecting scanners. If you're not sure about which numbers to specify, check 
all the boxes.
To use the SCSI Check feature:
1. Choose the Get SCSI Chain command. The SCSI Check dialog box will appear.
2. If your scanner does not show, click on the Probe button. Make sure your scanner 

is connected and turned on before clicking on the Probe button.
3. Make sure the correct interface cad is shown in the card selection box. If not, 

choose the correct interface card.
4. Check the numbered box corresponding to your scanner (or scanners).



Exiting ScanWizard
To exit Scan Wizard for Windows, double click on the close box on the upper left side 
of the Preview window.



The View Menu

The View menu lets you:
· Get a full page preview of an image
· Get a zoomed-in (enlarged) view of an image
· Resize the preview window
· Show or hide the Settings, Information, and Scan Job windows 



Full Page Preview
This command shows one of the two viewing modes available for your image (the 
other being the zoomed preview).
The full page preview is a preview of your image as defined by the parameters set in 
the Preview Setup command (in the Preferences menu). For instance, if your image is 
8" x 5" but the dimensions in the Preview Setup are 4" x 3", your full page preview 
will be 4" x 3". 
The maximum size of the full page preview varies, depending on your scanner model.
For example, if the scan bed (the glass surface) of your scanner has a maximum size 
of 8.5" x 11", the maximum full page preview will be limited to those dimensions. 
The size of the full page preview can be changed by setting new dimensions in the 
Preview Setup command. The new dimensions will take effect, however, only after 
you click on the Preview button so that the scanner does a new preview; only then 
will you see the new dimensions of the full page preview.
You may wish to change the size of your full page preview to improve performance 
and save memory. A smaller preview area will occupy less memory, speed up 
processing, and yield a higher -resolution preview. This is because ScanWizard takes 
your preview image and calculates dynamically how best to display that image in the 
smaller preview area    resulting in a higher-resolution view.
How to use Full Page Preview 



Zoomed Preview
This command displays the magnified view of your image when you use the Zoom 
Preview tool. 
The zoomed preview is the view of a specific part of the image shown in higher 
resolution with more visible detail. If you have zoomed preview enabled, the view is 
stored in memory, and you can easily switch between full page preview and zoomed 
preview. 
The zoomed preview is different from the zoomed-in view obtained from the 
Magnifying Lens tool. The zoomed-in view is simply an enlarged view, but it is not in 
high resolution. 
How to use Zoomed Preview 



Resize Window to Fit
This command adjusts the Preview window to fit the preview area. 
Sometimes, the preview window is larger than the preview area, as denoted by an empty
space below the vertical ruler. In other instances, the preview window may also exceed 
the preview area if you manually enlarged the preview window (by dragging on the 
Windows resize box).    To utilize window space more efficiently, use this command to 
resize the preview window.
How to use Resize Window to Fit    



Show / Hide commands
These commands allow you to switch between showing or hiding the Settings, Scan 
Job and Information windows on your screen. The commands also have their tool-
button counterparts in the form of three arrowheads onthe right edge of the toolbar.
How to use Show / Hide commands 



The Help Menu
The Help menu lets you access online help for the ScanWizard
The Help menu users standard Windows conventions for obtaining online help. If 
you're not familiar with this procedure, refer to your Microsoft Windows user's guide
· About 



About
This command gives you information on the ScanWizard for Windows scanning 
software, which is referred to in the About screen as the ScanWizard scanner 
controller.



The Preferences Menu

The Preferences Menu lets you
· Choose the correct scan material
· Create effects like invert
· Create effects like mirror
· Create cursor lines to help you with alignment
· Control the size of your Preview window
· Create a smoked glass background to help distinguish the current scan frame
· Set other options, such as specifying a working directory for files



Scan Material
This command allows you to select the correct scan    material. Scan materials can be 
generally classified into three types:
· Reflectives, such as photographs or prints.
· Positives, such as slides.
· Negatives, such as the negative film you use for your camera
The default scan material selection depends upon the scanner you're using, and the 
choices available to you will also depend on your equipment. 
The positive option, for instance appears only if you're using a Transparent Media 
Adapter (TMA) with your scanner. The negative option appears only if you have DCR 
installed and are using the TMA to scan a negative. If you are scanning negatives or 
positives, make sure you specify the correct scan material type, or you will get 
inaccurate scanning results.
How to use Scan Material 



Invert
This command creates a negative of an image. The Invert effect is applied to the 
whole preview image; it cannot be used for only a specific portion of the image.
When an image is inverted, the brightness value of each pixel is converted to the 
inverse value on the 256-step color values scale. For example, a pixel in positive 
image with a value of 255 is changed to 0, and a pixel with a value of 5 is changed to 
250.



Horizontal Mirror
This command allows you to flip the image so that a mirror effect is created. The 
Mirror effect is applied to the whole preview image; it cannot be used for only a 
specific portion of the image.
When the mirror image appears, the scan frame will still be in the old location, and 
you will need to move the scan frame if you wish to define another area.

 





Cursor Auxiliary Lines
This command allows you to create horizontal and vertical grid lines with your cursor 
to help define a scan frame precisely. Using the grid lines, you can read the 
measurements off your ruler more easily. 
How to use Cursor Auxiliary Lines 



Preview Setup
This command allows you to set the dimensions for your Preview area. To use a 
particular option, click on the box before the option. A check will appear in it to 
indicate that the option is enabled.
Click on the topic for information.

How to set the preview area



Live Preview
If this option is checked, the ScanWizard Plug-in will immediately show changes that 
you make to the preview image. You can turn off Live Preview if you're previewing or 
scanning only in grayscale; this will speed up the process.
If Live Preview is on:
· Changes you make to the preview image are shown instantly (for example, 

switching from color to grayscale)
· If you're scanning in grayscale and live preview is on, the image appears in color 

unless you specifically change image type in the Type box (in the Settings 
window) to a grayscale mode. This happens because Live Preview always does 
previews in color.

If Live Preview is off:
Your preview will be in accordance with your image type (i.e. if you have a grayscale 
image, your preview is in grayscale; with a color image, you get a color preview). If 
you apply any image-enhancement control, the changes will not be apparent until 
you do a new preview (click on the Preview button again).
Live Preview applies only to color scanners. If it is enabled, the next option, Color 
Preview, will be dimmed.



Color Preview
Color Preview is for color image type only.
This option applies only to three-pass color scanners, and is enabled only if Live 
Preview is not selected. If this option is turned on, the image will be scanned in 
whatever scan mode is specified in the Type box (in the Settings window). If it is 
turned off, the image will be scanned in grayscale.



Fast Preview
This option allows you to choose your preview mode. If Fast Preview    is on, the 
preview process is faster, but the quality of the preview image is a little coarse. If 
Fast Preview is off, the preview process is slower, but the quality of the preview 
image is improved. 
The Fast Preview option is a hardware-related feature and may or may not be 
available, depending on your scanner model.



The Preview Area
The Preview Area lets you select the size of your preview area, and includes the 
following options: Letter, A4, legal, maximum size, or custom size.
· Maximum refers to the maximum scan area that can be supported by your 

particular scanner model.
· Custom will appear if you type in your own specifications and changes any of the 

edit boxes.
· The Top, Left, Width and Height edit boxes allow you to specify the dimensions of 

the preview area. Top an Left refer to the starting points of the preview area on 
the x and y coordinates. Width is the expanse of the preview area, and Height is 
the depth of the preview area.

· The unit of measurement, indicated to the right side of the Top box, is the unit 
selected in the Settings window.



Keep Preview Image
This command allows you to keep the preview image in the preview window even 
after you exit ScanWizard for Windows. This way, the previous preview image still 
comes up the next time you bring up the software. This command allows you to 
retain the last preview image you used; the preview image is kept in the preview 
window after you exit ScanWizard. 
The next time you start up ScanWizard, this last preview image is again displayed in 
the preview window.    
To use this feature: 
Choose the Keep Preview Image command in the Preferences menu. A check appears
next to the command when it is enabled.



Smoked Glass Background
This command helps you distinguish the current scan frame from the rest of the 
material for greater visibility of the current scan frame. 
With the Smoked Glass feature turned on, the part of the image within the current 
scan frame will stand out, while the rest of the image (the "irrelevant" material) is 
relegated to a background resembling smoked glass.
If you have multiple scan frames, only the current scan frame stands out, and the 
inactive scan frames are hidden behind the smoked glass screen. 
The Smoked Glass Background, then, helps you focus on the part of the image within 
the current scan frame, and is particularly helpful when you are editing a scan frame 
or applying image-enhancement controls. This way, the changes can be seen more 
clearly and stand out from the rest of the material. (See the next section for more 
details. )
To use this feature:
Choose the Smoked Glass Background command in the Preferences menu. A check 
appears next to the command when it is enabled.
For accurate results, make sure you enable the Live Preview option (in the Preview 
Setup command, in the Preferences menu).



More
This command allows you to specify a working directory where you can save all 
temporary and data files, including files for job templates.

To use this feature:
1. Choose the More command in the Preferences menu. The dialog box    appears.
2. Click and hold down the Working Directory box, and from the pop-up menu that 

appears, choose your working directory.
3. If you click on the folder icon, the Directory Browser dialog box appears. Choose 

your    working directory, then click OK to close this dialog box. 
Whatever directory you specify is automatically added to the pop-up menu above 
for you to choose from in the future. If the directory you specify is not found or 
does not exist, a warning message appears, and the current directory of the 
ScanWizard for Windows    is used instead. 

4. When you have completed your choices, click OK to close the More Preferences 
dialog box. For the changes to take effect, exit ScanWizard, then relaunch the 
program.



The Tool Buttons
The Tool buttons simplify the performance of certain tasks. The Tool buttons are (left 
to right) Zoom Preview, Scan Framel, Magnifying Glass, Hand, and Color Picker.



 Zoom Preview tool
The Zoom Preview tool gives you the zoomed preview, which is an enlarged, high-
resolution view of an image with more visible detail. 
The zoomed preview is different from the zoomed-in view, which is obtained by using 
the Magnifying Lens tool and is not a high-resolution view. By using the Zoom Preview
tool and creating the zoomed preview, you can then switch easily between full page 
preview and zoomed preview. 
How to use the Zoom Preview tool 



 Scan Frame tool
The Scan Frame tool lets you create or modify a scan frame, which is the active area 
on which controls and commands can be applied. You can have multiple scan frames, 
but only one can be current at a time; the current scan frame is indicated by a 
marquee (marching ants). The current scan frame can be more easily distinguished if 
you turn on the Smoked Glass Background command (in the Preferences menu).
How to use the Scan Frame tool 



 Magnifying Lens tool
The Magnifying Lens tool enlarges your view of the preview image, allowing you to 
set the scan frame with greater precision if you need to. Only your view of the image 
is changed; the actual size of the image remains unaffected.
Each click magnifies or reduces by a factor of 2. Thus, the magnification levels 
increase from 100% to 200%, to 400%, and to the maximum 800%. 
If the portion that you want to magnify includes most of the preview area, the Lens 
tool will magnify the view only slightly. To solve this, enlarge the size of the preview 
area (through the Preview Setup command), or create a smaller selection area.
How to use the Magnifying Lens tool 



 Hand tool
The Hand tool lets you scroll through a preview image, allowing you to move parts of 
the image into view. The Hand tool can be used for zoomed-in images (enlarged 
through the Magnifying Lens tool), or images not included completely within the 
frame of the preview window (for instance, if your preview image is 8 inches wide and
you resized the width of your preview window to only 5 inches). 
How to use the Hand tool 



 Color Picker tool
The Color Picker tool allows you to sample color from an area of an image and to 
designate a new shadow or highlight point. 
With the Color Picker tool, you can determine the color values for any pixel in an 
image. When you click on the Color Picker tool and pass over a pixel, the value of that
pixel will be displayed in the Information window, based on the sample size also 
selected in the Information window. Pixel-value information is useful especially when 
you're making color adjustments based on color values.
How to select a new shadow or highlight point 
How to restore original settings 
How to change a sample size of the Color Picker 
How to display color information for a pixel or an averaged area 



The Action buttons
The Action Buttons generate a specific action from the scanning software. The Action 
buttons include Preview and Scan.



Preview button
The Preview button gives you a preliminary view of the image on your scanner bed. 
Previewing an image gives you greater flexibility, as it allows you to apply various 
controls to the preview image before actually scanning it in. With the preview image 
displayed, you can apply image enhancements or crop the image before performing 
the final scan.



Scan button
The Scan button lets you scan in the image in your scanner and delivers it to your 
image-editing software. The scanned image is based on the specifications you have 
chosen in the Settings window and on controls you may have applied to the preview 
image if a preview was performed. 



Rulers
The rulers on both sides of the preview window help you with operations that need 
precise measurement and alignment of your image.
The unit of measurement in the rulers is determined by the unit of measurement you 
have selected. This can be done either in the Image Dimension controls, located in 
the Settings window, or by clicking on the ruler unit button at the 0,0 point of the 
rulers in the Preview window.
Depending on your chosen unit of measurement, the rulers can mark off 
measurement in these units: inch, centimeter, millimeter, point, and pixel. The pixel 
option is dimmed if the selected resolution unit is lpi.
To select the unit of measurement for rulers:
Click on the unit box in the Settings window, or click on the ruler unit button at the 
0,0 point of the rulers in the Preview window. When the submenu appears, select the 
unit of measurement.



Preview Area
The preview area is where the preview image appears. 
The size of the preview area varies, depending on your scanner model. The size can 
be changed, however, through the Preview Setup command in the Preferences menu.
You can increase the size of the preview area to see more detail in your image, or you
can reduce the preview area to save on memory. 
For details on how to change the size of the preview area, refer to the Preview Setup 
command in the Preferences menu section.



Scan Material Status icon
Another way to access the Scan Material menu is to use the Scan Material Status 
icon, located to the right of the Scan Button.
The Scan Material Status icon is related to the use of the Transparent Media Adapter 
(TMA) for scanning slides and filmstrips with your scanner. With the TMA in use, the 
appearance of the icon will change, depending on whether your scan material is a 
reflective photo or print, or whether it is a positive or negative transparency 
/filmstrip.
· If you're scanning a reflective (such as a photo or print), or if you're not using the 

TMA, this icon will appear in its normal form like ordinary icon. When you click on 
the icon and hold down the mouse, you will see the Reflective option checked.

· If you're scanning a positive transparency or filmstrip, this icon will appear in the 
form of a positive. When you click on the icon and hold down the mouse, you'll 
see the Positive Transparency option checked.

· If you're scanning a negative transparency or filmstrip, this icon will appear in the 
form of a negative. When you click on the icon and hold down the mouse, you'll 
see the Negative Film option checked.



 
 Show / Hide Window buttons

These buttons allow you to show or hide the Settings, Scan job and Information 
windows on your screen.
To use this feature:
Click on a button for viewing a window. When the window appears, you can click on 
the button again to hide it 



Unit of Measurement button
The unit of measurement allows you to select your unit of measure. The options 
include inch, centimeter (cm), millimeter (mm), point, and pixel.



The Settings Window
The Settings window contains the commands for outputting your scanned image and 
includes the image-enhancement tools of the program.



Output Image Parameters
The Output Image Parameters include the various controls that determine how your 
image is scanned and processed.
The Output Image parameters include:
· Type 
· Resolution
· Resolution Unit Selectiom
· Image Dimension controls



Type (Image Type or Scan Mode)
The Type menu determines what your resulting scan will be. It does not refer to the 
original image mode. For instance, if you have a color photo but choose 256 
grayscale for the scan mode, the photo is scanned and processed as grayscale. 

The options available in the Type menu will depend on the type of scanner you have. 
For example, if you have a 36-bit scanner, the option Billions of colors will be active. If
you only have a grayscale scanner, the options relating to color will be dimmed.
How to use the Type 



Resolution
Resolution in the Settings window refers to the desired resolution for outputting the 
image to a device, such as a monitor or printer. It does not refer to the resolution in 
which the image is scanned. The maximum output resolution is dynamically 
calculated by the system as determined by the maximum scanner resolution and the 
scaling setting. 
Resolution is also related to scaling, or how large or small the image will be scanned 
relative to the original. When you change resolution, the scaling may be affected 
slightly if the resolution you selected has no exact equivalent in scaling. 
To set your resolution:
Enter a resolution setting in the Resolution edit box. There is no need to press the 
Enter key; typing in a value automatically inputs it into the system. If the value you 
enter is too low or too high, the minimum or maximum resolution value is entered for 
you instead.
Note:    In setting resolution, choose the setting that best matches your output device.
Remember that the higher the resolution, the larger the resulting file will be and the 
longer it will take to output.



Resolution Unit Selection
The unit of measurement for resolution is in dpi (dots per inch) and lpi (lines per inch)
Lpi settings are dimmed if the ruler unit is in pixels.

To select your unit option:
· Choose dpi if you know precisely the resolution you need for your image. For more

details on resolution, see the Basic Concepts chapter in the manual.
· Choose lpi Draft to produce resolution that is one times the screen frequency (no 

higher than 72 pixels per inch). Draft quality may result in output images that 
look a little blurred or indistinct at edges.

· Choose lpi Medium to produce resolution that is one and one-help times the 
screen frequency.

· Choose lpi Final to produce resolution that is two times the screen frequency.



Image Dimension controls
These controls allow you to adjust the various factors that affect the image, including 
the width and height for your image when it is first scanned (input), the scaling 
factor, and the dimensions of the image when it is finally output.



Mathematical Formula

This is a mathematical formula expressing the relation of the input dimensions to 
scaling and how they affect the dimensions when the image is scanned.
· Input width and input height refer to the dimensions of the scan frame that you 

draw. For example, if the image on your scanner is 5" x 7" and you draw a scan 
frame that is 3" x 4", then your input width will show 3.000 and your input height 
will show 4.000.

· Output width and output height refer to the dimensions of the image when output
to an output device (such as a monitor or printer).

The input width, input height, output width, output height are affected by your 
scaling and whether or not the Aspect Lock is on. 
How to use the Input-Output demensions 
How to use the Aspect Lock 
How to use Scaling 



Aspect Lock
The Aspect Lock allows you to keep the ratio of the image width and height constant. 
How to use the Aspect Lock 



Scaling control
The Scaling control lets you create large or small images so that the images don't 
have to be resized subsequently, which is usually done in your image-editing 
software.
How to use Scaling    



Unit of Measurement
The Unit of Measurement allows you to select you unit of measure. The options 
include inch, centimeter (cm), millimeter (mm), point, and pixel.



Size
The Size indicates how big the file will be when you accept the dimensions shown in 
the edit boxes, together with the resolution setting that you selected. Size is 
calculated automatically.



Image Adjustment controls
The image adjustment controls include the Auto button and the Color Correction 
button, located below the Image Status Controls.
· Auto
· Color Correction (DCR)



Auto (Automatic Contrast Control)
The Auto button optimizes the contrast of scanned images by making adjustments to 
the    Shadow/Midtone/Highlight values. The Auto button will be dimmed if the image 
type selected in the Type box is line art or halftone.
How to use the Auto control 



Color Correction (DCR)
This tool applies a generic color correction profile to your images to give it accurate, 
lifelike color. By default, the Color Correction feature is turned on. If you have 
Microtek's    DCR color calibration and correction system installed, the Color 
Correction button will override the generic color profile and apply DCR to the image.
A generic color profile is provided with the scanning software to correct the minor 
color shifts that occur invariably with scanners. To achieve optimal color correction, 
however, you need a true color calibration and correction system like Microtek's DCR,
or Dynamic Color Rendition, developed expressly for this purpose.
DCR creates an industry-standard color profile matched to your scanner, so that 
colors in your scanned image are adjusted to their optimal levels. DCR comes 
standard on certain ScanMaker models and is available as an option on other models.
The Color Correction button is turned on by default, but it can be turned off by 
clicking on the button again. Color Correction will be dimmed in the following 
instances:
· If image type in the Settings window is set to billions of colors, any grayscale 

setting, line art, or halftone.
· If the scan material type chosen (in the Scan Material command, Preferences 

menu) is Negative.
How to use the Microtek Calibrator    



Image Enhancement Tools
The Image- enhancement tools provide you with various tools for adjusting your 
image.
· Brightness, Contrast, and Exposure
· Tints
· Shadows and Highlights
· Curve
· Filters
· More Options



Brightness, Contrast and Exposure tool

The Brightness, Contrast and Exposure (BCE) tool changes the brightness, contrast 
and exposure setting of the entire image.
Brightness is the balance of light and dark shades in an image, while contrast is the 
range between the darkest and lightest shades in the image. On the other hand, 
exposure works like the exposure feature in photography, allowing you to change 
exposure of the image by increasing for reducing available light to the image. The 
Exposure control is a scanner hardware-related feature, and using it correctly can 
allow more detail to emerge in an image, especially if it was underexposed. 
The goal in using the BCE tool is to get the fullest dynamic range possible for your 
image. Because the BCE tool affects the image as a whole, you can try using the 
Shadows and Highlights tool instead to get the effects you want if you find that BCE 
tool alters your image too much.
How to use the BCE tool 



Contrast Control
The Contrast control lets you change the contrast setting.
· High contrast can make an image look like a photocopy of a picture with little or 

no gray shades.
· Low contrast can make an image look dull and flat.



Brightness Control
The Brightness control lets you change the brightness setting.
· Too much brightness can make an image look washed out.
· Very low brightness levels can make an image look very dark.



Channel Control
The channel control lets you change exposure settings for a particular color channel 
(red, green or blue).



Exposure Control
The Exposure control lets you increase or reduce available light to the image, This 
can be used to allow more detail to emerge in an image, especially if it was 
underexposed.
· More exposure can result in lighter images with more visible detail. The higher the

exposure, the longer it takes to scan the image.
· Less exposure can make an image dark and without detail.



The Action Button in the AIE dialog box
Click on an action button to achieve a particular effect. The Action button in the AIE 
dialog box carry out a specific action. 
The OK button
Clicking on this button will apply whatever image enhancements you have performed
on the current scan job, and close the AIE dialog box. Clicking OK is not the same as 
switching to another scan job (if you have multiple scan jobs). If you switch scan jobs,
the effects are applied to your current scan job, and then the new scan job shows up; 
you do not exit the AIE dialog box.
The Cancel button
Clicking on this button will cancel out all image-enhancement changes you have 
made to the current scan job, and then close the AIE dialog box.
The Reset button
Clicking on this button brings up the Reset dialog box, where you can specify which 
settings are to be reset, then click Reset or Cancel. If Reset is selected, the settings 
are restored to their default values; if Cancel is selected, the operation has no effect.
The Revert button
Clicking on this button cancels out the changes you made with the current image-
enhancement tool. This means that if you used several tools (and achieved a look 
that is the cumulative effect of all the tools), using Revert will cancel the effect of 
only the current tool and preserve the effects of the other preceding tools.



Choose your scan job here
This is where you select the scan job to which image enhancement will be applied. 
(Note: For definition of a scan job, see the Scan Job section of the Reference). If you 
have multiple scan jobs, you can switch among the various jobs, and the thumbnails 
will change accordingly to show the selected scan job.
Important
Switching to a new scan job while using the AIE dialog box will make any changes to 
the currently selected scan job permanent. This cannot be undone even by selecting 
the Cancel button.



Left thumbnail: Before enhancements
This is the thumbnail of the image captured by your scanner. The left thumbnail is the
"before" version -- which shows the effects of the last saved settings values.



Right thumbnail: After enhancements
This is the thumbnail of the image captured by your scanner. The right thumbnail is 
the "after" version -- which shows the effects of the new settings added in the AIE.



Image-Enhancement Tools
To select another image-enhancement tool, click on any of the buttons displayed in 
the vertical toolbar on the right side of the dialog box. 



The Tints tool

The Tints tool adjusts the hue or saturation of colors. This tool applies only to color 
images and is not available for use with grayscale or black-and-white images.
Hue is the aspect of color that distinguishes one color from another (whether it is red,
green or blue). In the RGB color mode, hue can be distinguished by its position in the 
color wheel. 
Saturation, on the other hand, refers to the intensity of color (more red in an apple, 
more green in the grass). Increasing saturation can have a dramatic effect on the 
colors of an image, but beware of increasing saturation too much, as it creates 
artificial-looking, overly bright colors.
The Tints tool is useful when your image has a particular color cast and you wish to 
remove the cast to make the image look more natural. The Tins tool is also related to 
the Scan Material command in the Preferences menu. For reflectives or positives, the 
Tints tool lets you adjust hue and saturation. For negatives, the Tints tool provides 
additional controls for selecting film type and adjusting exposure. 
How to use the Tints tool 



Color Wheel
The Color Wheel shows you the position of colors: green is across magenta, and red is
across cyan. By moving the pointer (a small dot) to a place in the color wheel, the 
hue of the image is altered. For instance, if you move the pointer towards the green 
area of the wheel, the image will acquire a greenish cast.



Saturation bar
The Saturation bar lets you change the intensity of the hues (colors) in your image. 
Use Saturation selectively, because increasing saturation will intensiify all hues in the
image.



Film Type Selection bar
The Film Type Selection bar allows you to select the type of film you used for your 
negative. Choosing the correct film type is important for maintaining image quality, 
and you should choose the film type that's indicated on the packaging that came with
your film.
The Film Type Selection box provides several choices for you to choose from. If your 
type of film is not in the list but a similar film type from the same company is 
available, you may choose from one of them. Very often, similar films from the same 
company use identical film types. For example, Kodak 135, ASA 100, ASA 200, and 
ASA 400 are grouped as the same type    ASA 100.
If your film type is not in the selection list and you cannot find its family group, 
choose Generic Negative Film.



Exposure Correction bar
The Exposure Correction bar lets you    adjust the exposure of a negative. An 
overexposed negative looks dark (with the image itself in the dialog box appearing 
bright), while an underexposed negative appears light (with the image itself 
appearing dark).
· If your film is overexposed (image is too bright), drag the bar to the left; this will 

make the image darker.
· If your film is underexposed (image is too dark), drag to the bar to the right; this 

will make the image lighter.



The Shadows and Highlights tool

The Shadows and Highlights tool lets you change the shadow and highlight point of 
an image.
By using this tool, you can manipulate shades so that the Shadow point becomes the 
new darkest value and the Highlight point becomes the new lightest value. Shades 
that are darker than the shadow then become black, and shades lighter than the 
highlight become white. For example, if you set the highlight point to 200, all points 
in the image with a value greater than 200 will be a mapped to value of 255, since 
255 represents the "whitest" white.
The Shadows and Highlights tool can be used for both grayscale and color images. If 
you have a limited range of grays between your lightest and darkest point, using 
shadow and highlight will have the effect of extending the range of grays and make 
more detail in the image visible. This tool is not available for use with line art or 
halftone scan modes. 
How to read and correct a histogram 
How to use the Shadows and Highlights tool 



Histogram
The Histogram is a graphic representation of how all the pixels in an image are 
distributed across brightness and darkness levels. The darkest pixels are at the left; 
the lightest pixels are at the right.
· A histogram skewed heavily to the left indicates that the image has many more 

dark pixels than light.
· A histogram skewed heavily to the right will indicate a light image as it has more 

light pixels than dark.
· The height of the histogram indicates the number of pixels at that point in the 

histogram.



Triangles
The Triangles (indicators) below the histogram adjust the Shadow, Midtone, and 
Highlight settings.
· The black triangle (left) controls the shadows. Moving this triangle to the right will

emphasize shadows and create a darker image.
· The gray triangle (middle) controls the midtones and indicates how the brightness

and darkness pixels are divided. Moving it to a value less than 1.0 will have the 
effect of darkening the image. Moving it to a value greater than 1.0 will have the 
effect of lightening the image.

· The white triangle (right) controls the highlights. Moving this triangle to the left 
will emphasize highlights and create a lighter image.

Note: The gray and white triangles will change in color if a color channel (not Master) 
is selected in the Channel box.



Histogram bar
The Histogram bar shows the distribution of shades from dark to light (left to right). 
The distribution of shades changes as you move any of the triangles.



Input edit boxes
The input edit boxes show how pixels are distributed over the 0-to-255 pixel scale.
The input values are related to the position of the indicators along the histogram. For 
example, if you move the left triangle in from 0 to 30, the input range becomes 30 to 
255, and pixels in the range of 0 to 30 are then set to 0. In a process called mapping, 
the new range (30 to 255) is stretched back to become 0 to 255. The image then 
becomes darker, since all pixels from 0 to 30 are now mapped to black (whereas 0 to 
30 before had subtle gradations from black that lightened up gradually). 
The same principle applies when you move in the right triangle, and the highlights in 
the image become more pronounced.
Moving in any of the triangles above the input boxes will change the values in the 
edit boxes. You can observe how the values in the boxes are affected by moving the 
triangles, or you can enter values into the boxes directly. In both cases, the histogram
will change accordingly.



Output edit boxes
The Output edit boxes show the 0-to-255 pixel range to where the Input levels are 
mapped. For example, if you modified the input values to 30 and 255 and then 
change output values to 0 to 250, the input values of 30 to 255 will be "stretched" to 
fit the output range of 0 to 250. This means you have a total of 250 shades (250-
0=250).
Unless you have very specific effects in mind, it is better to leave this feature alone, 
so everything is always mapped to 255 shadows (255-0). You can experiment with 
this feature to see what it does, however, and how it interacts with the input levels.



Original / Enhanced box
The Original / Enhanced box lets you choose which histogram to see: the original, 
before the image was modified; or enhanced, after the image had been modified 
(with shadows and highlights or any other tool).



Channel button
The Channel button lets you control the Shadow and Highlight settings for a 
particular color channel (red, green or blue) or for the Master channel (red, green, 
and blue simultaneously).



Input / Count / Percent
The Input / Count / Percent figures provide information about the histogram. The 
figures will appear only when the cursor is inside the histogram or if a triangle is 
being moved.
· Input value indicates the color value of the data displayed in the histogram.
· Count value indicates the number of pixels at the Input value. If Input value is 2 

and Count value is 1300, then there are 1300 pixels in the image at the input 
value of 2.

· Percent value is the percentage of all pixels in the image where color value is less 
than or equal to the input value. If Percent is 15% and Input value is 2, it means 
that 15% of all pixels in the image have a value of 2 or less.



The Curve tool

The Curve tool lets you control the gamma, which measures the intensity affecting 
the mid-level grays (midtones) of an image. Adjusting the gamma lets you change 
the values of the middle range of gray tones without dramatically altering the 
shadows and highlights.
In many ways, the Curve tool gives you the most control for adjusting an image's 
values, but novice users may take some time to master its intricacies. The Curve tool 
applies to grayscale and color images and is not available for use with line art or 
halftone scan modes.
How to read the curve 
How to use the Curve tool 



Curve
The Curve is a graphic representation of the gamma showing scanner input from dark
on the left to light on the right.



Method
The Method option sets the kind of curve you wish to have. Select from Line, Curve or
Gamma.



Channel
The Channel option allows you to choose the color or gray channel in which the 
gamma will be affected.



Curve buttons
The Curve buttons let you modify the curve. The tools are the pointer, zoom frame, 
and hand.
How to use the Curve buttons 



Pointer button
Use the Pointer button to define points in the curve that will be modified. When you 
click on any point in the curve, a control point will appear to mark your position. To 
remove a control point, drag it off the graph.



Zoom Frame button
Use the Zoom Frame button to zoom in on a particular point in the curve. Once the 
area is zoomed in, you can then use the pointer tool to define new points for more 
precision. This is particularly useful for working with 12-bit images, as more detail can
be seen in such images. The zoom level can be seen in the Zoom column. To zoom 
out, hold down the Shift key and click on the mouse simultaneously.



Hand button
Use the Hand button to scroll through the curve if the curve has been zoomed in. The 
Hand tool can be used only if the curve has been zoomed in with the Zoom Frame 
button (above). Otherwise, the Hand tool will be dimmed. 



Save button
The Save button allows you to save the curve. To do this, click on the Save button 
and specify a file name for the curve to be saved. 



Load button
The Load button allows you to use a previously saved gamma curve for another 
image. To do this, click on the Load button, then specify the curve to be loaded. 



The Filters tool

The Filters tool lets you apply or create special effects to your images. This tool is 
disabled when your image type is set to billions of colors, 1,000 shades of gray 
(grayscale), line art, and halftone.
How to use the Filters tool 



Show Filter Effect on Preview Image
To preview filters and see their effects immediately, click on this box.



Filters

The filters include:
· Blur and Blur More
· Sharpen and Sharpen More
· Edge Enhancement
· Emboss
· Unsharp Masking 



Blur filters
The Blur filters eliminate noise in the parts of the image where significant color 
transitions occur. The Blur filters decrease the contrast between adjacent pixels, 
making the image appear hazy and out of focus.
· Blur smoothes out the transitions by lightening pixels next to the hard edges of 

defined lines and shaded areas.
· Blur More produces an effect three or four times stronger than Blur.



Sharpen filters
The Sharpen filters do the opposite of the Blur filters and increase the contrast of 
adjacent pixels, making images appear sharper and more focused. 
Both Sharpen and Sharpen More filters improve clarity. The Sharpen More filter has a 
stronger sharpening effect than the Sharpen filter.



Edge Enhancement filter
The Edge Enhancement filter give greater contrast to edges. The filters can do this 
because edges are usually areas in an image where gray or color levels change 
abruptly.



Emboss filter
The Emboss filter makes a selection appear raised or stamped by suppressing the 
color within the selection and then tracing its edges with black.



Unsharp Masking
The Unsharp Masking filter adjusts the contrast of edge detail and creates the illusion
of more image sharpness. This filter can be useful for refocusing an image that has 
become blurry from interpolation or scanning. 



The More Options tool

The More Options tool provides you with additional scanner and image controls. 
These controls include:
· Descreen
· Velocity
· Gray Scan CCD Filter
· Using the linear gamma curve
To use the controls in the More Options tool:
Click on the More Options tool in the Settings window. When the More Options screen 
appears, select the particular control to be modified and its option, then click OK.



Descreen
Descreen allows you to remove moiré patterns in images.
A moiré is an undesirable pattern in printing that results from incorrect screen angles 
of overprinting halftones. Moirés usually result when you scan images taken directly 
from a magazine (instead of scanning a continuous glossy photographic original or a 
transparency).

How to use Descreen 



Velocity
The Velocity command adjusts the speed with which the scanner moves during 
scanning.
As the scanner processes the image and sends it to the computer, the scanner is also
getting more information continuously from the moving scanner mechanism. If the 
computer cannot store the image data as fast as the scanner sends it, the scanner 
mechanism has to stop while the scanner waits for the computer to catch up. These 
brief pauses during scanning sometime cause the quality of the scan to go down, and
images then appear with blurs or lines running across them. It is important, then, to 
select a slower scanning speed.

Slower scanning speeds give better image quality, but Auto is the recommended 
setting, as it provides the best balance between speed and image quality. If your 
images appear to have velocity-related problems, try lowering your velocity, and 
experiment with different settings until you find the fastest velocity at which the 
images are in good quality and appear to have no lines in them.
How to use Velocity 



Scan Quality
This control allows you to specify the quality of your scan in relation to your scanning 
speed.
· If Draft is selected, the scanning speed is faster but image quality is not as good 

as when Final is selected. Draft is the default option.
· If Final is selected, image quality is better than Draft, but scanning speed is a little

slower. 



Gray Scan CDD Filter
This option allows you to select a particular color channel when scanning grayscale 
images and is useful for obtaining certain effects. When scanning grayscale images, 
one of the color channels of the CCD is usually used for scanning; this can be the red,
green or blue color channel.



Use Linear Gamma Curve
This control allows the scanning software to read only raw image data, so that no 
color adjustment (not even the generic color correction profile) is applied to your 
image when it is scanned.
This control is helpful for professional graphic designers who wish to create very 
specific effects and are thoroughly familiar with the scanning process. If you are not 
familiar with this feature, leave this option turned off.



The Window Expansion button
The Window Expansion button lets you expand the Settings window to its full size, 
with the bottom half of the window revealing the image-enhancement controls.
When the bottom half of the Settings window is open, you can use the image-
enhancement functions directly by dragging on the slide bar for each control. This is 
like clicking on the image-enhancement tool, which takes you to the Advanced Image
Enhancer (AIE) dialog box where you can change the controls.
Using the slide bars to adjust images may be faster, but using the image-
enhancement tools gives you greater control over adjusting images and shows you 
"before-and-after" images in the AIE dialog box. 
To close the bottom half of the window, click on the Window Expansion button again.



Error Messages
Apple Shared Library Manager is not installed or found! Install the disk named Apple 
Shared Library Manager.
Bad or corrupted Color Correction profile. 1) Reinstall    ScanWizard or 2) if you have a 
DCR target, calibrate your scanner.
Bad or invalid curve file: File is too long!
Bad or invalid Finder information!
Bad or invalid curve file: Corrupted data values!
Bad or invalid file for folder!
Bad or missing resource! Please re-install ScanWizard.
Bad scanner driver manager function code!
Can't create Macintosh window!
Can't read image file.
Cannot access selected Negative Color Correction profile! 1) Reinstall ScanWizard    or
2) if you have a DCR target calibrate your scanner.
Cannot read from file! see Troubleshooting Tip #15 in the manual.
Cannot write to file See Troubleshooting Tip #15 in the manual.
Color Correction profile for negative film cannot be found! Reinstall ScanWizard.
Color Correction profile for positive transparencies cannot be found! Reinstall    
ScanWizard.
Color Correction profile is missing! 1) Reinstall ScanWizard or 2) if you have a DCR 
target, calibrate your scanner.
Color Correction was canceled by user!
Current Color Correction module does not support the DCR profile present on this 
system!
Curve data file is corrupted.
Curve file contains too many control points! Delete the file and try again.
Curve has too many control points to be saved as a Photoshop curve (maximum is 
19)!
Default Color Correction profile for negative    film cannot be found! Reinstall 
ScanWizard.
Descreen value is invalid! Choose one in the range.
Error communicating with scanner. See Troubleshooting Tip#10 in the manual.
Error in writing scan jobs to the preferred folder. Do you want to write to current 
folder?
Error processing the scanned image! Restart your computer and try again.
Error removing the scanner drive from memory!
File or folder does not exist!
Flag in Sequencer call unrecognized!
Illegal value specified in edit box.



Improper Color Correction Setup: Microtek Preferences folder does not exist!
Incorrect preview are defined!
Insufficient disk space for internal processing!
Insufficient disk space to save image!
Internal AIE buffers do not fit inside preview window!
Internal Error: Applying unconstructed sequence!
Internal Error: Cannot construct sequence! Please restart ScanWizard.
Internal Error: Check parameters to Sequencer!
Internal Error: Color Correction (DCR) module is not found!
Internal Error: Damaged resource! Please reinstall ScanWizard.
Internal Error: Error made in IP routines when calculating a LUT!
Internal Error: Not enough memory! Please restart ScanWizard.
Internal Error: Not enough memory. Auxiliary buffer specified is less than 5 image 
rows!
Internal Error: Sequencer was called to copy from ORGB buffer!
Invalid scan job number! Restart ScanWizard and try again.
Negative material does not allow billions of colors and 1000's of gray shades. Convert
to millions    of colors or 256 shades?
No Color Correction profiles are found! 1) Reinstall ScanWizard or 2) If you have a 
DCR target, calibrate your scanner.
No available scan jobs.
No scan job has been saved!
No scan jobs checked.
No scanner driver is installed or found!
Not enough memory to perform Color Correction.
Not enough memory to read image!
Not enough memory!
Permission is denied to the folder!
Reset shadow, highlight, and midtone to default values?
Resource is corrupted. Reinstall ScanWizard.
SJDB Get UISB failed!
Scan job name is more than 31 characters long.
Scanner driver is not loaded! Please restart ScanWizard.
Scanner is not ready! See Troubleshooting Tip #15 in the manual.
Select a scan job before deleting!
Setting shadow or highlight values will turn off "Auto" button. Proceed anyway?
System Preferences folder does not exit!
System folder does not exist! Reinstall your Macintosh operating system.



ScanWizard requires System 7.0 or later!
The frame size of this job exceeds the current preview image bounds. Adjust the 
frame size and add it?
There may be incorrect values in the edit box.
This functions requires System 7.0 or later to run.
This setup does support multiple acquisitions!
Too many control points are specified in the curve (maximum is 64)!
Turning on "Use linear gamma curve" will turn off "Color Correction" button. Proceed 
anyway?
Two identical flags gives to Sequencer!
Unable to locate the job files in the folder specified. Do you want to try the current 
folder?
Use A4 to display image!
You cannot delete the last scan job. One job must always be there.
You must enter a name for the scan job!






